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En esta guía…
Esta guía contiene información para aprender a utilizar su Software 
MassHunter Workstation de Agilent - Qualitative Analysis con datos GC/MS. 

Antes de comenzar los ejercicios, lea las instrucciones de “Antes de comenzar 
los ejercicios...” en la página 5.

Ejercicio 1 Aprender los conceptos básicos del análisis cualitativo

En este ejercicio, explorará algunas de las potentes capacidades del programa 
Qualitative Analysis. Estas tareas son importantes, con independencia del 
tipo de datos que utilice.

Ejercicio 2 Buscar y encontrar

En los primeros dos conjuntos de tareas, encontrará e identificará fármacos 
de sulfamida de baja concentración dentro de una matriz compleja y generará 
sus fórmulas para datos TOF y Q-TOF. También podrá realizar una extracción 
molecular en una digestión de proteína con datos TOF y Q-TOF. Estas tareas 
también se pueden realizar en datos Triple Quad.

Ejercicio 3 Utilizar flujos de trabajo, exportación e impresión

En estas tareas, aprenderá a configurar y ejecutar cualquier método de 
análisis cualitativo. También aprenderá a editar un método para automatizar 
el análisis y/o la identificación del compuesto. Después, ejecutará las acciones 
dentro de un método automatizado cuando abra un archivo de datos. También 
aprenderá a crear un método para realizar acciones automatizadas con una 
lista de trabajo. Cada una de estas tareas se realiza usando un flujo de trabajo 
distinto.

Referencia

En este capítulo, aprenderá conceptos básicos sobre el programa Qualitative 
Analysis.
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Novedades

en B.06.00

• Puede revisar los compuestos en Compound Details View. En Compound 
Details View hay disponibles cuatro ventanas adicionales.

• En Compound Details View, puede establecer distintas definiciones de 
líneas para distintos tipos de cromatogramas y espectros.

• Está disponible el algoritmo Find Compounds by Integration.

• Puede buscar en múltiples bibliotecas el algoritmo de búsqueda en 
bibliotecas por unidades de masa.

• En el algoritmo Generate Formulas, puede seleccionar si desea anotar 
picos de espectros fragmentales con fórmulas. La anotación de fragmentos 
selecciona los espectros que se anotan en función del algoritmo de 
explotación de compuestos.

• El algoritmo Generate Formulas puede ejecutarse en compuestos que se 
encuentren a través del algoritmo Find by Chromatogram Deconvolution.

• El algoritmo Generate Formula han sido modificado para permitirle 
introducir una cantidad máxima de resultados para cada portador de 
carga.

• En el algoritmo Generate Formulas, puede agrupar resultados con la 
misma fórmula, pero con distintos portadores de carga.

• Los compuestos pueden crearse a partir de cualquier espectro de usuario. 
El algoritmo de explotación de compuestos correspondiente a dichos 
compuestos es “Extracción de espectros”.

• Cuando guarde los resultados con un archivo de datos, puede seleccionar si 
desea guardar todos los resultados de los compuestos en un archivo de 
datos o un conjunto más reducido de resultados por cada compuesto. 
Todos los cromatogramas y espectros de usuarios se guardan siempre.

• El formato de archivo CEF ha sido modificado para incluir más 
información.

• La información m/z y sobre especies iónicas está disponible en el primer 
nivel de la tabla Spectrum Identification Results.

• Se ha modificado la tabla Spectrum Identification. Puede añadir un filtro a 
una columna y eliminar filas.

• Ahora puede etiquetar un pico con Formula & Ion Species.
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• Ahora es mucho más rápido cambiar el espectro que ha sido etiquetado 
como Best en la ventana Spectrum Identification Results cuando dispone 
de una gran cantidad de entradas.

• Puede especificar superponer cromatogramas de compuestos en 
Compound Report.

• Se ha modificado la plantilla de informe por defecto Formula Confirmation 
para incluir la columna coloreada Flags (Tgt) y Fragment Table en la 
columna coloreada Flags (FIs).

Antes de comenzar los ejercicios...
• Instale el software. Consulte la Guía de instalación para obtener 

instrucciones.

• Copie la carpeta con el nombre Data del disco de instalación en un formato 
sin comprimir en cualquier destino de su disco duro. 

Esta carpeta contiene todos los archivos de datos necesarios para los 
ejercicios. Es posible que necesite extraer primero los archivos de datos 
con formato .zip.

NOTAS No reutilice los archivos de datos de muestra que ya tiene en su ordenador a menos que 
sepa que ha copiado los originales del dicso y que usted es la única persona que los utiliza. 
Si los archivos de datos de muestra que se encuentran en el sistema no coinciden 
exactamente con los originales del disco, los resultados obtenidos durante los ejercicios no 
coincidirán con los que aparecen en la guía.
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Software MassHunter Workstation de Agilent Qualitative Analysis
Guía de familiarización
1
Aprender los conceptos básicos del 
análisis cualitativo

Tarea 1. Abra el programa Qualitative Analysis 10

Tarea 2. Configurar la interfaz de usuario para datos GC/MS 13

Tarea 3. Acercar y alejar el zoom del cromatograma 16

Tarea 4. Anclar un cromatograma 17

Tarea 5. Cambiar el diseño de una ventana 18

Tarea 6. Extraer cromatogramas 20
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Tarea 11. Añadir un calibrador de masa 44

En este ejercicio, explorará algunas de las muchas capacidades potentes del 
programa Qualitative Analysis para trabajar con datos GC/Q-TOF y GC/QQQ.

Cada ejercicio se presenta en una tabla con tres columnas:

• Pasos: utilice estas instrucciones generales para avanzar a su ritmo en la 
exploración del programa.

• Instrucciones detalladas: recurra a ellas si necesita ayuda o prefiere usar 
un proceso de aprendizaje paso a paso.

• Comentarios: léalos para aprender consejos e información adicional sobre 
cada paso de un ejercicio.
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1 Aprender los conceptos básicos del análisis cualitativo
Tarea 1. Abra el programa Qualitative Analysis
Tarea 1. Abra el programa Qualitative Analysis

En esta tarea, abrirá múltiples archivos de datos usando el método actual. 

 

Tarea 1. Abra el programa Qualitative Analysis con múltiples archivos de datos

Pasos Instrucciones detalladas Comentarios

1 Abra el programa Qualitative 
Analysis. 
• Abra los archivos de datos, Pest 

- 200 - Scan.d, Pest - STD 200 
MRM.d, Pest Strawb-01 
SPIKED 1 ppb - 1 ul inj.d y 
MSD_mix_4stds_DG_spl200_0
3.d en la carpeta 
\\MassHunter\Data, o en la 
carpeta en la que los haya 
copiado.

a Haga doble clic en el icono Agilent 
MassHunter Qualitative Analysis 
B.06.00, . 
El sistema muestra el cuadro de 
diálogo Open Data Files.

b Vaya a la carpeta \\MassHunter\
Data\GC o la carpeta en la que se 
ubican los archivos de ejemplo.

• El archivo Pest - 200 - Scan.d 
contiene datos MS, y los archivos 
Pest - STD 200 MRM.d y Pest 
Strawb-01 SPIKED 1 ppb - 1 ul inj.d 
contienen tanto datos MS como 
MS/MS (todos GC/QQQ). 
MSD_mix_4stds_DG_spl200_03.d 
contiene datos GC/Q-TOF.

• Puede obtener ayuda en la mayoría 
de ventanas, cuadros de diálogo y 
pestañas pulsando la tecla F1 con 
la ventana activa.

• Asegúrese de que el botón Use 
current method está pulsado.

• Asegúrese de que la casilla de 
verificación Load result data no 
está marcada. Si la casilla de 
verificación Load result data no 
está disponible, no se han 
guardado los resultados en el 
archivo de datos. Aprenderá a 
guardar resultados en “Tarea 17. 
Guardar resultados” en la 
página 68, que contiene 
instrucciones sobre cómo 
guardar resultados.

• Asegúrese de que la casilla de 
verificación de Run ‘File Open’ 
actions from selected method 
está desmarcada.

Figura 1 Abrir archivos de datos al abrir el software
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Aprender los conceptos básicos del análisis cualitativo 1
Tarea 1. Abra el programa Qualitative Analysis
c Pulse y mantenga presionada la tecla 
Mayúscula mientras hace clic en Pest 
- 200 - Scan.d, Pest - STD 200 
MRM.d, Pest Strawb-01 SPIKED 1 
ppb - 1 ul inj.d y 
MSD_mix_4stds_DB_spl200_03.d.

d Haga clic en Open.
Los cuatro archivos de datos se 
muestran en la ventana Data 
Navigator, y en la ventana 
Chromatogram Results se muestran de 
1 a 3 cromatogramas.

e Haga clic en el icono List Mode, , 
de la barra de herramientas 
Chromatogram Results.

• Si pulsa la tecla Ctrl, puede 
seleccionar archivos que no sean 
directamente contiguos en la lista.

• Lo que ve en la ventana principal en 
este momento dependerá del 
método, diseño, pantalla y de la 
configuración de la representación 
que utilice antes de abrir estos 
archivos.

• Cuando haga clic en el icono List 
Mode, el fondo del icono cambiará a 
color naranja.

Tarea 1. Abra el programa Qualitative Analysis con múltiples archivos de datos (continuación)

Pasos Instrucciones detalladas Comentarios
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1 Aprender los conceptos básicos del análisis cualitativo
Tarea 1. Abra el programa Qualitative Analysis
Figura 2 Ventana principal de Qualitative Analysis con el flujo de trabajo GC/Q-TOF Compound Screening 
cargado. 

Tarea 1. Abra el programa Qualitative Analysis con múltiples archivos de datos (continuación)

Pasos Instrucciones detalladas Comentarios

Icono de Número 
máximo de paneles

Icono de opciones de 
visualización

Pulse el botón X para 
cerrar la ventana.
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Aprender los conceptos básicos del análisis cualitativo 1
Tarea 2. Configurar la interfaz de usuario para datos GC/MS
Tarea 2. Configurar la interfaz de usuario para datos GC/MS 

En esta tarea, cambiará al flujo de trabajo General (para clientes GC/QQQ) o al 
flujo de trabajo GC/Q-TOF Compound Screening (para clientes GC/Q-TOF). 
Estos dos flujos de trabajo son los únicos que permiten analizar datos GC/MS. 
Seguidamente, abra el cuadro de diálogo User Interface Configuration y marque 
las casillas de verificación apropiadas del sistema GC/QQQ o GC/Q-TOF.

Tarea 2. Configurar la interfaz de usuario para GC

Pasos Instrucciones detalladas Comentarios

1 Si es necesario, abra el programa 
Qualitative Analysis. 

a Haga doble clic en el icono Agilent 
MassHunter Qualitative Analysis, 

. 
El sistema muestra el cuadro de 
diálogo Open Data Files.

b Haga clic en Cancelar en el cuadro de 
diálogo Open Data Files.

• Puede obtener ayuda en cualquier 
ventana, cuadro de diálogo o 
pestañas pulsando la tecla F1 con 
la ventana activa.

2 Cambie al flujo de trabajo General 
o al flujo de trabajo GC/Q-TOF 
Compound Screening.

a Si dispone de un instrumento 
GC/QQQ, haga clic en el comando 
Configuration > Configure for 
Workflow > General. Si dispone de un 
instrumento GC/Q-TOF, haga clic en el 
comando Configuration > Configure 
for Workflow > GC/Q-TOF Compound 
Screening.

b Haga clic en el botón Load workflow’s 
default method y el botón Load 
workflow’s default layout.

c Haga clic en OK.
d Haga clic en el icono List Mode, , 

de la barra de herramientas 
Chromatogram Results.

• Si el programa Data Acquisition de 
GC/QQQ o GC/Q-TOF se instala en 
el mismo ordenador, el software 
configura la Interfaz de Usuario de 
forma automática. La sección 
GC/Q-TOF Compound Screening 
puede estar ya disponible en la 
ventana Method Explorer.

• Por defecto, los cromatogramas se 
superponen. En estos ejemplos, los 
cromatogramas se muestran en List 
Mode.
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1 Aprender los conceptos básicos del análisis cualitativo
Tarea 2. Configurar la interfaz de usuario para datos GC/MS
3 Si dispone de un GC/QQQ, 
configure la interfaz de usuario 
para mostrar solo las funciones 
GC/QQQ.

a Haga clic en Configuration > User 
Interface Configuration.

b En Separation types, marque solo la 
casilla de verificación GC.

c Si dispone de un instrumento 
GC/QQQ, en Ionization type, marque la 
casilla de verificación EI or other 
“hard” ionization technique y 
desmarque la casilla de verificación CI, 
APCI, ESI, MADLDI u otra técnica de 
ionización “suave”.

d En Mass accuracy, desmarque la 
casilla de verificación Accurate mass 
(TOF, Q-TOF). Marque la casilla de 
verificación Unit mass (Q, QQQ).

e En las funciones de software 
opcionales, desmarque la casilla de 
verificación Peptide Sequence Editor y 
la casilla de verificación BioConfirm 
Software.

f En Non-MS detectors, desmarque las 
casillas de verificación UV y ADC.

g Marque la casilla de verificación Show 
advanced parameters.

h Haga clic en OK.

• Puede cambiar los comandos que 
están disponibles en el cuadro de 
diálogo User Interface 
Configuration. 

• Si una función no aparece, 
probablemente ha sido ocultada al 
desmarcar una casilla de 
verificación en el cuadro de diálogo 
User Interface Configuration.

Figura 3 Configurar la interfaz del usuario para utilizarla con datos GC/QQQ

Tarea 2. Configurar la interfaz de usuario para GC

Pasos Instrucciones detalladas Comentarios
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Aprender los conceptos básicos del análisis cualitativo 1
Tarea 2. Configurar la interfaz de usuario para datos GC/MS
4 Si dispone de un GC/Q-TOF, 
configure la interfaz de usuario 
para mostrar solo las funciones 
GC/Q-TOF.

a Haga clic en Configuration > User 
Interface Configuration.

b En Separation types, marque solo la 
casilla de verificación GC.

c En Ionization type, marque ambas 
casillas de verificación.

d En MS levels, marque ambas casillas 
de verificación.

e En Mass accuracy, marque la casilla 
de verificación Accurate mass (TOF, 
Q-TOF). Desmarque la casilla de 
verificación Unit mass (Q, QQQ).

f En las funciones de software 
opcionales, desmarque la casilla de 
verificación Peptide Sequence Editor y 
la casilla de verificación BioConfirm 
Software.

g En Non-MS detectors, desmarque las 
casillas de verificación UV y ADC.

h Marque la casilla de verificación Show 
advanced parameters.

i Haga clic en OK.

• Puede cambiar los comandos que 
están disponibles en el cuadro de 
diálogo User Interface 
Configuration. 

• Si una función no aparece, 
probablemente ha sido ocultada al 
desmarcar una casilla de 
verificación en el cuadro de diálogo 
User Interface Configuration.

Figura 4 Configurar la interfaz del usuario para GC/Q-TOF

Tarea 2. Configurar la interfaz de usuario para GC

Pasos Instrucciones detalladas Comentarios
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1 Aprender los conceptos básicos del análisis cualitativo
Tarea 3. Acercar y alejar el zoom del cromatograma
Tarea 3. Acercar y alejar el zoom del cromatograma

En esta tarea, se familiarizará con las características de acercamiento y 
alejamiento del zoom del programa Qualitative Analysis.
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Aprender los conceptos básicos del análisis cualitativo 1
Tarea 4. Anclar un cromatograma
Tarea 4. Anclar un cromatograma

En esta tarea, aprenderá a anclar un cromatograma. Cuando se ancla un 
cromatograma, este se visualiza de forma permanente en pantalla mientras se 
desplaza por los demás cromatogramas para visualizarlos.

Tarea 4. Anclar un cromatograma

Pasos Instrucciones detalladas Comentarios

• Anclar un cromatograma.
• Mostrar todos los 

cromatogramas.
• Asegúrese de que la lista de 

visualización de cromatogramas 
está ajustada en 1.

• En la ventana Chromatogram 
Results, seleccione el segundo 
TIC.

• Ancle este TIC.
• Desplácese por los 

cromatogramas.
• Desmarque el ancla.

a En Data Navigator, marque las casillas 
de verificación de los cromatogramas 
que ha ocultado en la tarea anterior.

b Asegúrese de que la cantidad máxima 
de paneles está ajustada en 1 en la 
ventana Chromatogram Results.

c En la ventana Chromatogram Results, 
seleccione el segundo TIC.

d Haga doble clic dentro del 
cromatograma y pulse Set Anchor.

e Utilice la barra de desplazamiento de la 
ventana Chromatogram Results para 
desplazarse por la lista de 
cromatogramas. El segundo TIC 
permanece siempre visible como el 
primer cromatograma. 

f Haga clic en Chromatograms > Clear 
Anchor.

• Cuando configura un ancla para un 
cromatograma, aparece el icono del 
ancla en la ventana Data Navigator 
junto al nombre del cromatograma 
anclado.

• Aparecen dos cromatogramas en la 
ventana Chromatogram Results 
después de anclar uno de ellos, 
aunque la lista de visualización 
muestre 1. Esto significa que puede 
ver un cromatograma además del 
cromatograma anclado.

• También puede hacer doble clic en 
el cromatograma y pulsar Clear 
Anchor en el menú de acceso 
directo.

Figura 5 TIC anclados en la ventana Chromatogram Results
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1 Aprender los conceptos básicos del análisis cualitativo
Tarea 5. Cambiar el diseño de una ventana
Tarea 5. Cambiar el diseño de una ventana

En esta tarea, puede desplazar las ventanas en la vista principal y crear varios 
diseños de ventana.

Tarea 5. Cambiar el diseño de una ventana

Pasos Instrucciones detalladas Comentarios

1 Cambiar el diseño de una ventana:
• Cambiar el tamaño de una 

ventana.
• Guardar el diseño de una 

ventana.
• Desbloquear el diseño.
• Cambiar la ventana 

Chromatogram Results para que 
quede flotando.

• Desplazar la ventana 
Chromatogram Results.

• Mostrar las herramientas para 
recolocar las ventanas.

• Para cambiar el tamaño de una 
ventana, arrastre los bordes entre 
ventanas.

• Parta guardar el diseño de una 
ventana, haga clic en Configuration > 
Window Layouts > Save Layout.

• Parta desbloquear un diseño, haga clic 
en Configuration > Window Layouts 
> Lock Layout. 

• Para hacer que una ventana quede 
flotante, haga clic con el botón derecho 
en la barra de título de la ventana y 
pulse Floating en el menú de acceso 
directo.

• Para desplazar una ventana, haga clic 
en la barra de título de la ventana y 
arrastre la ventana a la ubicación 
deseada. 

• Para visualizar las herramientas de 
reposicionamiento, arrastre la ventana 
sobre alguna de las demás ventanas. 
Cuando una ventana se superpone con 
otra, el programa muestra varias 
herramientas de diseño, como se 
muestra en Figura 6.

• Si el diseño está desbloqueado, el 
sistema no muestra una marca de 
verificación junto al menú Lock 
Layout.

• Solo puede usar las herramientas 
de recolocación cuando el diseño 
está desbloqueado.

• También puede hacer que una 
ventana quede flotante haciendo 
doble clic en la barra de título de la 
ventana.

• El software dispone de numerosos 
diseños. También puede intentar 
cargar diseños distintos.

• El software cuenta con varios flujos 
de trabajo diferentes. Cada flujo de 
trabajo carga un diseño diferente. Al 
cambiar a un flujo de trabajo 
distinto también se cambia el 
diseño.
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Tarea 5. Cambiar el diseño de una ventana
Figura 6 Herramientas de recolocación de ventanas

2 Recolocar la ventana 
Chromatogram Results.
• Desplace esta ventana para que 

quede en la parte superior, a la 
izquierda, a la derecha y en la 
parte inferior de las demás 
ventanas.

• Desplace dos ventanas juntas 
para que queden la una sobre la 
otra y estén disponibles solo 
mediante las pestañas 
inferiores. 

• Restaurar el diseño por defecto.

• Si arrastra el cursor por uno de los 
iconos más pequeños, la ventana que 
arrastra se colocará por encima, a la 
derecha, por debajo o a la izquierda de 
las demás ventanas. 

• Arrastre el cursor por el icono de mayor 
tamaño. La ventana también puede 
colocarse por encima, a la derecha, por 
debajo, o a la izquierda de la otra 
ventana arrastrando el cursor por los 
bordes del icono de mayor tamaño.

• Para tabular dos ventanas juntas, 
arrastre el cursor por el centro del 
icono de mayor tamaño. Verá una 
versión sombreada de las dos ventanas 
tabuladas juntas. Deje de arrastrar el 
ratón. Las dos ventanas se tabularán 
juntas.

• Haga clic en Configuration > Window 
Layouts > Restore Default Layout.

• El cursor deberá encontrarse sobre 
las flechas de un cuadro para que 
se lleve a cabo la recolocación.

• Hacer clic en el comando Restore 
Default Layout restaura el diseño 
que se emplea con el flujo de 
trabajo General y el flujo de trabajo 
GC/Q-TOF Compound Screening. Si 
está empleando un flujo de trabajo 
distinto, necesitará cargar el diseño 
que se emplea con dicho flujo de 
trabajo.

Tarea 5. Cambiar el diseño de una ventana (continuación)

Pasos Instrucciones detalladas Comentarios
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Tarea 6. Extraer cromatogramas

En esta tarea, se aprende a extraer y fusionar cromatogramas del TIC original. 

Tarea 6. Extraer cromatogramas

Pasos Instrucciones detalladas Comentarios

1 Extraer y fusionar cromatogramas 
iónicos (EICs) extraídos de dos 
masas en el archivo de datos Pest 
- 200 Scan.d.
• Los valores m/z son 129.0 y 

414.2.
• No fusionar los picos de masas 

individuales en un 
cromatograma.

a En la ventana Data Navigator, 
desmarque las casillas de verificación 
de los archivos de datos, excepto los 
de Pest - 200 Scan.d.

b Abra el cuadro de diálogo Extract 
Chromatograms, usando la siguiente 
opción o una de las opciones de la 
derecha: 
• Haga clic en Chromatograms > 

Extract Chromatograms.
c En List of opened data files, haga clic 

en Pest - 200 - Scan.d.
d En el cuadro de lista Type, seleccione 

EIC.
e En el campo m/z value(s), escriba 
129.0, 414.2

f Si es necesario, desmarque la casilla 
de verificación Merge multiple 
masses into one chromatogram para 
fusionar los EIC.

g Haga clic en OK.
h Ajuste Maximum number of list 

panes a 3 en la barra de herramientas 
Chromatogram Results.

• También puede extraer 
cromatogramas de una de las 
siguientes formas:
• Haga doble clic dentro del 

cromatograma, y pulse Extract 
Chromatogram.

• Desde Data Navigator, resalte 
TIC Scan para sulfas_PosMS.d, 
y a continuación haga clic con el 
botón derecho en TIC Scan y 
pulse Extract Chromatograms.

• Ahora puede usar un nivel MS de 
All o MS.

• Téngase en cuenta que también 
puede elegir integrar 
automáticamente el cromatograma 
extraído después de la extracción.

• También puede extraer un 
cromatograma desde un espectro 
de masa.
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Figura 7 Cuadro de diálogo Extract Chromatograms

Figura 8 Cromatogramas iónicos extraídos (EICs) y fusionados 
comparados con el TIC original 

Tarea 6. Extraer cromatogramas (continuación)

Pasos Instrucciones detalladas Comentarios
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Tarea 7. Integración interactiva de un cromatograma GC/MS

En esta tarea, aprenderá distintas formas de integrar un cromatograma, 
cambiar parámetros de integración para modificar los resultados y calcular la 
relación de señal y ruido de los picos integrados en relación con datos MS/MS.

Tarea 7. Integración interactiva de un cromatograma (GC/MS)

Pasos Instrucciones detalladas Comentarios

1 Integrar el archivo de datos TIC 
Scan chromatogram for the Pest - 
200 - Scan.d usando cualquiera de 
las opciones que aparecen a la 
derecha.

a Archivo de datos Mark the Pest - 200 - 
Scan.D de la ventana Data Navigator.

b Resalte el cromatograma TIC Scan y 
utilice uno de los siguientes 
comandos:
• Desde la barra de menús, haga clic 

en Chromatograms > Integrate 
Chromatogram.

• Haga doble clic en cualquier lugar de 
la ventana de cromatogramas, y 
pulse Integrate Chromatogram.

• En la ventana Data Navigator, 
seleccione Pest - 200 - Scan.D > 
User Chromatograms > TIC Scan, y 
seguidamente haga clic con el botón 
derecho en TIC Scan y después en 
Integrate Chromatogram.

• Nótese que el programa integra 
prácticamente todos los picos del 
cromatograma.

• Seleccione el integrador que se usa 
en datos MS, datos MS/MS y datos 
GC en la ventana Method Editor.

• Este cromatograma es un 
cromatograma MS, de manera que 
los valores que se han ajustado en 
la sección Integrate (MS) de 
Method Editor se emplean en la 
integración de este cromatograma.

2 Mostrar solo dos cromatogramas 
al mismo tiempo.

• Seleccione 2 en el recuadro Maximum 
number of list panes de la barra de 
herramientas Chromatogram Results.

Figura 9 Cromatograma TIC Scan con muchos picos pequeños

Se integran muchos picos pequeños.
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3 Cambiar el umbral para integrar 
menos picos.
• Cambiar el umbral para 

conservar solo los tres picos de 
mayor tamaño.

a Desde la ventana Method Explorer, 
haga clic en Chromatogram > 
Integrate (MS) para visualizar la 
pestaña Integrate (MS).

b Seleccione el integrador Agile.
c Haga clic en la pestaña Peak Filters.
d En Maximum number of peaks, 

marque Limit (by height) to the 
largest, y escriba 3.

• Nótese el triángulo azul que 
aparece cuando cambia una 
configuración desde el valor 
guardado en el método actual. 
Cuando guarda el método, 
desaparece el triángulo.

Figura 10 Pestaña Peak Filters con Limit (by height) to the largest 
marcado

4 Reintegrar el cromatograma e Haga clic en el botón  de la barra 
de herramientas de Method Editor 
para integrar utilizando la nueva 
configuración.

• Nótese que solo se integran los tres 
picos de mayor tamaño.

• El pico de 2.491 tiene una altura 
mayor que el pico de 16.858 
minutos, de manera que se 
selecciona como el tercer pico.

Tarea 7. Integración interactiva de un cromatograma (GC/MS) (continuación)

Pasos Instrucciones detalladas Comentarios
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Figura 11 Cromatograma TIC Scan integrado al limitar el número de picos

5 Integrar el cromatograma TIC 
MRM para el archivo de datos Pest 
- STD 200 MRM.D.

a En la ventana Data Navigator, 
seleccione el archivo de datos TIC 
MRM for the Pest - STD 200 MRM.d. 

b Use uno de los siguientes comandos 
para integrar los cromatogramas.
• Desde la barra de menús, haga clic 

en Chromatograms > Integrate 
Chromatogram.

• Haga doble clic en cualquier lugar de 
la ventana de cromatogramas, y 
pulse Integrate Chromatogram.

• En la ventana Data Navigator, haga 
doble clic en el cromatograma 
resaltado y pulse Integrate 
Chromatogram.

c Amplíe la imagen de 5,8 a 8,5 minutos.
d Ajuste Maximum number of list 

panes a 2.

• Pulse la tecla Ctrl para resaltar más 
de un cromatograma en la ventana 
Data Navigator.

• Nótese que el programa integra 
prácticamente todos los picos del 
cromatograma.

• Estos cromatogramas son 
cromatogramas MS/MS, de manera 
que los valores que se han ajustado 
en la sección Integrate (MS/MS) de 
la ventana Method Editor se 
emplean en la integración de este 
cromatograma. Puede seleccionar 
un integrador para integrar 
cromatogramas MS y otro 
integrador distinto para integrar 
cromatogramas MS/MS.

Tarea 7. Integración interactiva de un cromatograma (GC/MS) (continuación)

Pasos Instrucciones detalladas Comentarios
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Figura 12 Cromatogramas MRM integrados 

6 Seleccione el integrador MS/MS 
(GC). Cambie el filtro para aceptar 
únicamente picos con una altura 
absoluta superior o igual a 20.000.

a Desde la ventana Method Explorer, 
seleccione Chromatogram > 
Integrate (MS/MS).

b Seleccione MS/MS (GC) como 
Integrator.

c Haga clic en la pestaña Peak Filters.
d En Filter on, haga clic en Peak height.
e En Height filters, marque la casilla de 

verificación Absolute height.
f Escriba 60000 como Absolute 

height.

• Nótese el triángulo azul que 
aparece cuando cambia una 
configuración desde el valor 
guardado en el método actual. 
Cuando guarda el método, 
desaparece el triángulo.

Figura 13 Pestaña Peak Filters con Absolute height marcado

7 Reintegrar el cromatograma g Haga clic en el botón  de la barra 
de herramientas Method Editor.

• Nótese que solo se integran los 
picos de mayor tamaño.

Tarea 7. Integración interactiva de un cromatograma (GC/MS) (continuación)

Pasos Instrucciones detalladas Comentarios
Software MassHunter Workstation de Agilent - Guía de familiarización Qualitative Analysis para LC/MS 25



1 Aprender los conceptos básicos del análisis cualitativo
Tarea 7. Integración interactiva de un cromatograma GC/MS
Figura 14 TIC integrados y cromatogramas EIC MS/MS con un ajuste de umbral más alto

8 Restaure la configuración 
guardada para el método actual y 
cierre Method Editor.

a Seleccione la sección Chromatogram 
> Integrate (MS/MS) en Method 
Explorer.

b Haga clic en el icono  de Method 
Editor.

c Seleccione la sección 
Chromatogram > Integrate (MS/MS) 
en Method Explorer.

d Haga clic en el icono  de Method 
Editor.

e Cierre la ventana Method Editor.

• Para cancelar sus cambios y 
restaurar los valores desde el 
método cargado, haga clic en el 
icono Restore to last saved values 
from file , en la barra de 
herramientas Method Editor. 

9 Eliminar todos los cromatogramas 
excepto el original. Eliminar los 
resultados de integración desde el 
cromatograma original.

a En User Chromatograms de la ventana 
Data Navigator, resalte todos los 
cromatogramas excepto el original.

b Haga clic con el botón derecho en los 
cromatogramas resaltados y pulse 
Delete.

c Seleccione todos los cromatogramas 
TIC.

d Haga clic en Chromatograms > Clear 
Results.

• Cuando utilice el comando Clear 
Results, los cromatogramas no se 
eliminarán; los resultados 
conectados al cromatograma se 
eliminarán. En ese caso, los valores 
de integración se eliminarán.

Tarea 7. Integración interactiva de un cromatograma (GC/MS) (continuación)

Pasos Instrucciones detalladas Comentarios

El pico de menor tamaño a los 5,8 minutos 
ya no se incluye en los resultados de la 
integración porque la altura absoluta de 
este pico es inferior a los 60000 recuentos.
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Tarea 8. Calcular valores de idoneidad del sistema

En esta tarea, aprenderá distintas formas de integrar interactivamente un 
cromatograma, cambiar parámetros de integración para modificar los 
resultados y ver la relación de señal y ruido de cada pico. También aprenderá 
a activar los cálculos de idoneidad del sistema.

Tarea 8. Integración interactiva de un cromatograma (MS)

Pasos Instrucciones detalladas Comentarios

1 Integrar el cromatograma 
MSD_mix_4stds_DB_spl200_03.d 
y Pest - 200 - Scan.d usando 
cualquiera de las ocpiones que 
aparecen a la derecha.

a Marque la casilla de verificación 
situada junto al archivo de datos 
MSD_mix_4stds_DB_spl200_03.d en 
la ventana Data Navigator.

b Marque la casilla de verificación 
situada junto al archivo de datos Pest - 
200 - Scan.d en la ventana Data 
Navigator.

c Resalte ambos TIC.
d Integre el TIC Scan de ambos archivos, 

usando una de las siguientes 
opciones.
• Desde el menú principal, haga clic 

en Chromatograms > Integrate 
Chromatogram.

• Resalte el cromatograma. Haga clic 
con el botón derecho en el 
cromatograma y pulse Integrate 
Chromatogram.

• En Data Navigator, resalte TIC Scan 
para ambos archivos de datos. Haga 
clic con el botón derecho en el 
cromatograma, y pulse Integrate 
Chromatogram.

• Desde el flujo de trabajo General, la 
integración utiliza el integrador 
General porque se trata del 
integrador seleccionado en el 
método default.m. En el flujo de 
trabajo GC/Q-TOF Compound 
Screening, la integración emplea el 
integrador Agile. 

• Puede modificar este valor en la 
pestaña Chromatogram > Integrate 
(MS) > Integrator.

• Nótese que el integrador con 
parámetros por defecto detecta 
picos muy pequeños.
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Figura 15 Uno de los menús de acceso directo de Data Navigator y los cromatogramas integrados

2 Activar cálculos de idoneidad del 
sistema para los cromatogramas 
MS.

a Desde Method Explorer, seleccione 
Chromatogram > Integrate (MS) para 
visualizar la pestaña Integrator.

b Haga clic en la pestaña Suitability.
c Marque Enable system suitability 

calculations.
d Seleccione United States 

Pharmacopoeia (USP).
e En el recuadro Column void time, 

escriba 1.
f En el recuadro Column lenght, escriba 

3000.

• Nótese el triángulo azul que 
aparece cuando cambia una 
configuración desde el valor 
guardado en el método actual. 
Cuando guarda el método, 
desaparece el triángulo.

• Los algoritmos empleados para 
configurar varias de las columnas 
Integration Peak List cambian en 
función de la farmacopea 
seleccionada. Consulte la ayuda en 
línea para obtener más información.

Figura 16 Pestaña Chromatogram > Integrate (MS) Suitability

Tarea 8. Integración interactiva de un cromatograma (MS) (continuación)

Pasos Instrucciones detalladas Comentarios

Los valores de tiempo nulo de 
columna y longitud de columna 
de estos archivos de datos son 
en realidad diferentes. Se 
proporcionan únicamente a 
modo de ejemplo.
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3 Reintegrar el cromatograma. • Haga clic en el icono de Integrate 
Chromatogram , de la barra de 
herramientas de Method Editor 
utilizando la nueva configuración.

4 Visualice los cálculos de idoneidad 
del sistema.
• Abra la ventana Integration Peak 

List.
• Revise los valores de la región 

del ruido y calcule la relación 
señal-ruido de los picos 
integrados.

a Haga clic en View > Integration Peak 
List.

b Haga clic con el botón derecho en la 
cabecera de la ventana Peaks y haga 
clic en Floating.

c Haga clic con el botón derecho en la 
cabecera de cualquier columna que 
desea visualizar y haga clic en Remove 
Column. 

d Haga clic con el botón derecho en 
cualquier cabecera de columna y haga 
clic en Add/Remove Columns para 
cambiar las columnas visibles.

• Los cálculos de idoneidad del 
sistema se incluyen en la tabla 
Integration Peak List.

• Estos valores incluyen k’, Tailing 
factor, Plates, Plates/M y 
Symmetry.

• También puede activar los cálculos 
de idoneidad del sistema para un 
cromatograma MS, MS/MS y GC.

Figura 17 Tabla de picos integrados con valores de idoneidad del 
sistema

5 Restaurar la configuración del 
método por defecto y cerrar la 
ventana Method Editor y la ventana 
Integration Peak List.

a Para cancelar sus cambios y restaurar 
los valores desde el método cargado, 
haga clic en el icono de Restore to last 
saved values from file , en la 
barra de herramientas Method Editor. 

b Cierre la ventana Method Editor.
c Haga clic con el botón derecho en el 

título de la ventana Integration Peak 
List y haga clic en Floating.

d Haga clic en View > Integration Peak 
List.

• Cuando hace clic en el comando 
Floating del menú de acceso directo 
por segunda vez, la ventana 
Integration Peak List se acopla en 
su lugar de origen.

Tarea 8. Integración interactiva de un cromatograma (MS) (continuación)

Pasos Instrucciones detalladas Comentarios
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Tarea 9. Extraer espectros de un cromatograma

En esta tarea, se extraen espectros del lugar exacto que se ha especificado en 
el cromatograma. El programa Qualitative Analysis extrae un espectro de un 
punto concreto de datos, o extrae un espectro medio a partir de una media de 
puntos de datos o rangos múltiples. 

Tarea 9. Extraer espectros de un cromatograma

Pasos Instrucciones detalladas Comentarios

1 Extraiga un cromatograma para 
visualizar el ion precursor de los 
últimos picos de Pest - STD 200 
MRM.d.
• Amplíe la imagen en la región 

entre 13 y 16 minutos.
• Utilice el icono Walk 

Chromatogram.
• Revise los espectros que 

comienzan a aproximadamente 
13 minutos y desplace la flecha 
hacia la derecha. 

a Marque la línea Pest - 200 - MRM.D 
en la ventana Data Navigator.

b Cierre la ventana Method Editor.
c Cierre la ventana MS Spectrum 

Results.
d Haga clic en el cromatograma TIC 

MRM de la ventana Data Navigator.
e Haga clic en el icono de Autoscale 

Y-axis during Zoom, , en la barra 
de herramientas Chromatogram 
Results.

f Seleccione 1 como Maximum number 
of list panes.

g Para ampliar una imagen de unos 
pocos picos, haga clic con el botón 
derecho del ratón sobre el pico a los 13 
minutos y arrástrelo a los 16 minutos y 
a continuación suéltelo. 

h Haga clic en el icono de Walk 
Chromatogram, , en la barra de 
herramientas Chromatogram Results.

i Desplace el cursor Walk 
Chromatogram para colocarlo en una 
posición superior al eje X, 
aproximadamente a 13 minutos, y 
haga clic. 

j Para navegar de un espectro a otro, 
utilice las teclas de navegación 
derecha e izquierda de su teclado.

• La herramienta Walk 
Chromatogram es especialmente 
útil en datos MS/MS para 
identificar los iones precursor y de 
producto.

• El espectro de cada punto en que 
hace clic en la ventana 
Chromatogram Results se muestra 
automáticamente en la ventana 
Spectrum Preview, que se abre de 
forma automática.

• En ocasiones, dos espectros se 
muestran en la ventana Spectrum 
Preview. Por ejemplo, dos espectros 
se muestran en la ventana 
Spectrum Preview para cada punto 
en que hace clic cerca del pico de 
los 13,431 minutos.
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Figura 18 Extraiga un cromatograma para ver los dos espectros MRM del pico a 13,43 minutos

Tarea 9. Extraer espectros de un cromatograma

Pasos Instrucciones detalladas Comentarios
Software MassHunter Workstation de Agilent - Guía de familiarización Qualitative Analysis para LC/MS 31



1 Aprender los conceptos básicos del análisis cualitativo
Tarea 9. Extraer espectros de un cromatograma
2 Extrae espectros en puntos de 
datos concretos para el pico a los 
5,2 minutos y el pico a los 14,3 
minutos del archivo de datos Pest - 
STD 200 MRM.d.
• Extraiga un espectro del pico a 

los 5,2 min., o cercano a dicho 
valor, y seguidamente otro de 
valle, usando cualquiera de las 
opciones descritas en 
Comments.

• Extraiga un espectro desde el 
pico de los 14.3 minutos, o 
cercano a dicho valor. (todavía 
no de valle)

• Cambie la pantalla para mostrar 
al menos tres espectros.

a Haga clic en el icono de List Mode, 
, en la barra de herramientas 

Chromatogram Results.
b Cierre la ventana Spectrum Preview.
c Haga clic en el icono de Zoom Out, 

, en la barra de herramientas 
Chromatogram Results.

d Para ampliar al pico de los 5,2 minutos, 
haga clic con el botón derecho del 
ratón sobre el pico de los 4,0 min. y 
arrástrelo a los 6,0 min., y luego 
suéltelo. 

e En un pico cercano a los 5,2 min. 
extraiga un espectro usando 
cualquiera de los métodos de columna 
Comments.

f En un valle cercano a los 5.1 min., 
extraiga el espectro.

g Haga clic en el icono de Zoom Out, 
, en la barra de herramientas 

Chromatogram Results.
h Aumente la región entre los 14 y los 15 

min. 
i En un pico cercano a los 14,3 min. 

extraiga un espectro usando 
cualquiera de los métodos de columna 
Comments. (Todavía no extraiga el 
espectro de valle.)

j Si es necesario, seleccione 4 en el 
icono Maximum number of list panes 
de la barra de herramientas MS 
Spectrum Results.

• Cuando use el zoom, asegúrese de 
que el icono AutoScale Y-axis 
during Zoom, , muestra “on”. El 
fondo del icono es naranja cuando 
se encuentra activado.

• También puede extraer un espectro 
de una de las siguientes formas:
• Haga doble clic en el punto de 

datos del cromatograma. 
• Haga clic en el punto de datos del 

cromatograma, y, seguidamente, 
haga clic con el botón derecho en 
el cromatograma. Haga clic en 
Extract MS Spectrum. Se abrirá 
el cuadro de diálogo Extract 
Spectrum. Asegúrese de haber 
seleccionado el archivo Pest - 
STD 200 MRM.d y haga clic en 
Extract en el cuadro de diálogo 
Extract Spectrum dialog box.

• Nótese que cuando se extrae un 
espectro por primera vez, aparece la 
ventana MS Spectrum Results con 
el espectro y el tipo de espectro y 
tiempo de retención aparecen bajo 
User Spectra. Todos los espectros 
que se extraigan posteriormente 
aparecerán también en ambos 
lugares.

• Cuando extrae un espectro MS 
desde el pico cercano a los 14,3 
minutos, se extraen dos espectros 
porque se producen dos 
transiciones en dicho pico.

Tarea 9. Extraer espectros de un cromatograma

Pasos Instrucciones detalladas Comentarios
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Figura 19 Ventana principal con dos espectros MRM desde el pico de los 5,2 minutos y dos espectros MRM 
desde el pico a los 14,3 minutos

Tarea 9. Extraer espectros de un cromatograma

Pasos Instrucciones detalladas Comentarios
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3 Extraiga un espectro MS del valle a 
los 14,35 minutos del archivo de 
datos Pest - STD 200 MRM.d. 
• Abra Spectrum Preview.
• Extraiga un espectro desde el 

valle de los 14.3 minutos RT.
• Copie dicho espectro a la carpeta 

User Spectra.
• Cambie la pantalla para mostrar 

6 espectros.
• Apague Spectrum Preview.

a Haga clic en el icono Spectrum 
Preview, .

b En un valle cercano a los 14,3 minutos, 
extraiga un espectro.

c Haga clic con el botón derecho en un 
espectro de la ventana Spectrum 
Preview, y haga clic en Copy to User 
Spectra. Los espectros se copian a la 
sección User Spectra en Data 
Navigator y se muestran en la ventana 
MS Spectrum Results.

d Pulse la flecha hacia abajo junto a la 
lista de paneles de espectro, y 
seleccione 6.

e Cierre la ventana Spectrum Preview.

• Cuando se habilita Spectrum 
Preview, el sistema muestra 
cualquier espectro seleccionado 
manualmente en la ventana 
Spectrum Preview, pero no en la 
sección User Spectra de Data 
Navigator.

• Con Spectrum Preview habilitado, 
Qualitative Analysis sobreescribe el 
espectro anterior al extraer uno 
nuevo.

• El modo Spectrum Preview es útil 
cuando se desea revisar 
rápidamente los espectros de su 
cromatograma y guardar solo 
algunos de los espectros.

Figura 20 Ventanas Chromatogram Results y MS Spectrum Results

Tarea 9. Extraer espectros de un cromatograma

Pasos Instrucciones detalladas Comentarios
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4 Extraiga un espectro que promedie 
todos los puntos de un rango 
específico para el pico de los 14,3 
minutos en el archivo de datos 
Pest - STD 200 MRM.d:
• Aleje el zoom.
• Utilice el icono Range Select de 

la barra de herramientas 
Chromatogram.

• Configure el rango en todo el 
pico. 

• Extraiga el espectro mediante 
cualquiera de las opciones 
disponibles.

a Utilice el icono de Range Select, , 
en la barra de herramientas 
Chromatogram.

b Haga clic en la parte izquierda de la 
base del pico a los 14,3 minutos y 
arrastre la base del pico hacia la 
derecha. 

c Extraiga el espectro medio mediante 
una de las opciones de que dispone a 
la derecha.

d Seleccione 2 en Maximum number of 
list panes de la ventana MS Spectrum 
Results.

• Puede extraer un espectro 
promedio haciendo doble clic en el 
rango seleccionado del 
cromatograma. 

• También puede hacer clic con el 
botón derecho del ratón en 
cualquier lugar del cromatograma y 
pulse Extract MS Spectrum desde 
el menú de acceso directo.

• Nótese que aparecen dos espectros 
MRM promediados.

Figura 21 Chromatogram Results y MS Spectrum Results con dos espectros promediados

Tarea 9. Extraer espectros de un cromatograma

Pasos Instrucciones detalladas Comentarios
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5 Extraiga espectros que promedien 
los rangos de picos a los 5,2 
minutos y a los 14,3 minutos 
combinados para el archivo de 
datos Pest - STD 200 MRM.d.
• Sugerencia: Utilice el icono 

Range Select y la tecla Ctrl para 
seleccionar el rango de Pico 1 
desde el punto medio.

• Extraiga los espectros mediante 
cualquiera de las opciones de 
que dispone a la derecha.

a Haga clic en el icono de Zoom Out, 
, en la barra de herramientas 

Chromatogram Results.
b Pulse la tecla Ctrl.
c Haga clic en la parte izquierda del pico 

a los 5,2 minutos, arrastre el ratón 
hacia la derecha de dicho pico y 
suéltelo.

d Suelte la tecla Ctrl.
e Extraiga los espectros promediados 

usando esta opción, o alguna de las 
que dispone a la derecha:
• Haga doble clic dentro del rango 

seleccionado en cualquier pico.

• Recuerde que el segundo pico ya 
cuenta con un rango seleccionado 
desde el paso 4.

• Para extraer espectros, también 
puede hacer clic con el botón 
derecho del ratón en cualquier lugar 
del cromatograma y hacer clic en 
Extract MS Spectrum. Se abrirá el 
cuadro de diálogo Extract Spectrum. 
Haga clic en Extract.

Figura 22 Dos espectros promediados de dos rangos distintos en el cromatograma

Tarea 9. Extraer espectros de un cromatograma

Pasos Instrucciones detalladas Comentarios

El primer espectro cuenta con 
transiciones desde ambos rangos 
temporales. El segundo espectro 
únicamente cuenta con un rango 
temporal porque la transición 160.00 
-> ** no está presente en el pico de 
los 5,2 minutos.
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6 Reste un espectro de fondo cada 
vez que extraiga un espectro de 
pico desde Pest - STD 200 MRM.d.
• Elimine cualquier barrido en User 

Spectra de Data Navigator.
• Extraiga un espectro de fondo 

que sea el promedio de un 
espectro al inicio del pico y un 
espectro al final del pico.

• Extraiga un espectro de pico de 
los picos integrados.

a Haga clic en la línea User Spectra de 
Data Navigator. Haga clic con el botón 
derecho en la línea User Spectra y 
haga clic en Delete.

b Haga clic en Yes.
c En Method Explorer, seleccione 

Spectrum > Extract (MS/MS). 
d Haga clic en la pestaña Peak 

Spectrum Extraction (MS/MS), si no 
es visible.

e En la casilla Peak spectrum 
background MS/MS, seleccione 
Average of spectra at peak start and 
end.

f En la barra de herramientas 
Chromatogram Results, haga clic en el 
icono Peak Select, .

g Haga clic en el comando 
Chromatograms > Integrate.

h Seleccione el pico de los 5,206 minutos.
i Haga clic con el botón derecho y pulse 

en Extract Peak Spectrum desde el 
menú de acceso directo.

• Nótese que al final de este proceso, 
de los espectros de pico extraídos 
se restarán automáticamente los 
espectros de fondo elegidos.

Tarea 9. Extraer espectros de un cromatograma

Pasos Instrucciones detalladas Comentarios
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Figura 23 Espectros de pico con espectro de pico de fondo restado 

Tarea 9. Extraer espectros de un cromatograma

Pasos Instrucciones detalladas Comentarios
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7 Integre y extraiga espectros de 
pico desde el archivo de datos Pest 
- STD 200 MRM.d.

a Haga clic en el cromatograma TIC 
MRM de la ventana Data Navigator.

b Haga clic en Chromatograms > 
Integrate and Extract Peak Spectra.

• Los espectros de pico que reste 
manualmente en el paso anterior se 
borrarán automáticamente porque 
la casilla de verificación Clear 
previous peak spectra se 
encuentra marcada en la pestaña 
Chromatograms > Integrate 
(MS/MS) > Results.

Figura 24 Integrar y extraer espectros de picos

8 Eliminar los resultados de 
integración y los espectros de pico.

a Seleccione el archivo de datos Pest - 
Std 200 MRM.d.

b Haga clic en Chromatograms > Clear 
Results > Include Peak Spectra.

• También puede hacer clic en 
Chromatograms > Clear Results > 
Only Chromatograms si no desea 
borrar el espectro de pico.

Tarea 9. Extraer espectros de un cromatograma

Pasos Instrucciones detalladas Comentarios
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Tarea 10. Añadir anotaciones

Puede añadir una anotación de imagen o una anotación de texto en las 
siguientes ventanas gráficas:

• Ventana Chromatogram Results

• Ventana MS Spectrum Results

Si guarda los resultados del archivo de datos, también se guardan las 
anotaciones.

Tarea 10. Añadir anotaciones

Pasos Instrucciones detalladas Comentarios

1 Seleccione el archivo de datos 
MSD_mix_4stds_DG_spl200_03.d. 
Oculte los demás cromatogramas.

a Marque la casilla de verificación 
situada junto al archivo de datos 
MSD_mix_4stds_DG_spl200_03.D en 
la ventana Data Navigator.

b Haga clic en Edit > Show > Only 
Highlighted.

• Los cromatogramas de los demás 
archivos de datos se ocultan de 
manera automática.

2 Seleccione la ubicación del 
cromatograma en la que desea 
añadir una anotación de texto.

a En la ventana Chromatogram Results, 
haga clic en la herramienta Annotation 
( ) de la barra de tareas.

b Desplace el cursor a la ubicación del 
panel del cromatograma en la que 
desea añadir la anotación.

c Haga clic con el botón derecho y 
seguidamente haga clic en Add Text 
Annotation.

• El cursor cambia a una cruz. Se 
utiliza este cursor para seleccionar 
la ubicación exacta en la que añadir 
la anotación.

• La barra de herramientas Annotate 
está disponible en la ventana 
Chromatogram Results.

• También puede añadir anotaciones 
a la ventana MS Spectrum Results.
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3 Añada la información sobre la 
anotación de texto del cuadro de 
diálogo Add/Edit Text Annotation.

a Escriba el Texto de la anotación.
b Seleccione el Texto color.
c Seleccione la Orientación.
d Seleccione el Estilo de fuente y el 

Tamaño de fuente.
e Haga clic en Anclado o Flotante. Si 

selecciona Anclado, seleccione las 
opciones con las que el puntero 
anotará el texto. Si hace clic en 
Flotante, podrá cambiar la posición 
relativa. Es más sencillo cambiar la 
posición de manera interactiva en la 
ventana de gráficos.

f Haga clic en OK.

• Puede añadir múltiples anotaciones 
en un cromatograma o espectro.

• Puede utilizar los iconos de la barra 
de herramientas Annotate para 
seleccionar todas las anotaciones, 
borrar anotaciones y editar 
anotaciones.

Figura 25 Cuadro de diálogo Add/Edit Text Annotation y ventana Chromatogram Results

Tarea 10. Añadir anotaciones (continuación)

Pasos Instrucciones detalladas Comentarios

La barra de herramientas Annotate solo está disponible cuando 
se selecciona la herramienta Annotate.
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4 Seleccione la ubicación del 
cromatograma en la que desea 
añadir una anotación de imagen.

a Desplace el cursor a la ubicación del 
panel del cromatograma en la que 
desea añadir la anotación.

b Haga clic con el botón derecho y 
seguidamente haga clic en Add Image 
Annotation.

• Puede añadir un archivo de imagen 
JPG o MOL.

5 Añada la información sobre la 
anotación de texto del cuadro de 
diálogo Add/Edit Text Annotation.

a Escriba el Texto de la anotación.
b Escriba 50 para la anchura de Scale.
c Marque la casilla de verificación Lock 

aspect ratio.
d Haga clic en Floating. Puede cambiar 

la posición relativa. Es más sencillo 
cambiar la posición de manera 
interactiva en la ventana de gráficos.

e Haga clic en OK.
f Desplace la imagen a la esquina 

superior derecha del cromatograma.

• El archivo Agilent_Logo.tif está 
incluido en la carpeta \\
MassHunter\Report Templates\
Qual\B.05.00\en-US\Letter. Deberá 
convertirlo a archivo JPG.

• Puede añadir múltiples anotaciones 
en un cromatograma o espectro.

Figura 26 Cuadro de diálogo Add/Edit Image Annotation y ventana Chromatogram Results

Tarea 10. Añadir anotaciones (continuación)

Pasos Instrucciones detalladas Comentarios
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6 Amplíe la imagen al primer pico. • Haga zoom a una zona alrededor del 
primer pico de los 5,5 minutos

Figura 27 Cuadro de diálogo Add/Edit Image Annotation y ventana Chromatogram Results

7 Vuelva a la herramienta Range 
Select de la ventana 
Chromatogram Results. Elimine 
primero la anotación.

a Haga clic en el icono  para 
eliminar todas las anotaciones.

b Haga clic en el icono  (Range 
Select) de la barra de herramientas 
Chromatogram Results.

• Si desea guardar las anotaciones 
con los resultados del archivo de 
datos, consulte “Tarea 17. Guardar 
resultados” en la página 68.

• Puede cambiar entre cinco 
herramientas distintas en la barra 
de herramientas Chromatogram 
Results. Consulte la ayuda en línea 
para obtener más información. Las 
cinco herramientas son:
• Range Select
• Peak Select
• Manual Integration
• Walk Chromatogram
• Annotation Mouse

Tarea 10. Añadir anotaciones (continuación)

Pasos Instrucciones detalladas Comentarios

Si existe una anotación anclada, 
permanecerá acoplada a la posición en la 
que está anclada. Si amplía un pico diferente, 
es posible que las anotaciones ancladas no 
sean visibles. Si las anotaciones son 
flotantes, dichas anotaciones se mostrarán 
siempre en la misma posición relativa a la 
esquina superior izquierda de la ventana.
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Tarea 11. Añadir un calibrador de masa

El calibrador muestra la diferencia entre dos puntos de un espectro. También 
puede añadir un calibrador a la ventana MS Spectrum Results.

Si guarda los resultados del archivo de datos, también se guardan los 
calibradores.

Tarea 11. Añadir un calibrador de masa

Pasos Instrucciones detalladas Comentarios

1 Integre y extraiga espectros de 
picos desde 
MSD_mix_4stds_DG_spl200_03.d.

a Marque la casilla de verificación 
situada junto al archivo de datos 
MSD_mix_4stds_DG_spl200_03.D en 
la ventana Data Navigator.

b Haga clic en Edit > Show > Only 
Highlighted.

c Haga clic en Chromatograms > 
Integrate and Extract Peak Spectra.

d Cierre la ventana Method Editor.

2 Añada el calibrador al espectro de 
picos creado en la tarea anterior.

a En la ventana MS Spectrum, haga clic 
en la herramienta Delta Mass Caliper 
( ) de la barra de tareas.

b (opcional) Seleccione Profile Point to 
Point para el tipo de calibrador en la 
barra de herramientas Caliper.

c Aumente la imagen de 66 a 132 m/z.
d Desplace el cursor a la ubicación del 

panel de espectros en la que desea 
añadir el calibrador.

e Arrastre el cursor al punto final del 
calibrador en el espectro. Mientras 
arrastra el cursor, el valor de la masa 
delta cambia. Cuando suelte el botón 
del ratón, se añadirá el calibrador. 

• El cursor cambiará a una flecha. 
Utilizará el cursor para seleccionar 
el punto inicial y final del calibrador. 

• No puede seleccionar el tipo de 
calibrador si el espectro es 
baricéntrico porque Profile Point to 
Point no tiene efecto alguno en 
datos baricéntricos.

• El cursor “triángulo” se configura 
en la parte superior del pico 
seleccionado.
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3 Modificar el calibrador para utilizar 
un color distinto.

a Haga clic en el calibrador creado en el 
paso anterior.

b Haga clic en el botón Caliper Properties 
( ) de la barra de herramientas MS 
Spectrum Results Caliper.

c (opcional) Escriba los valores Start X y 
Start Y.

d Seleccione el Texto color.
e Seleccione el Estilo de fuente y el 

Tamaño de fuente.
f Haga clic en OK.

• Puede añadir múltiples calibradores 
a un espectro.

• Puede utilizar los iconos de la barra 
de herramientas Caliper para 
seleccionar todos los calibradores, 
y para borrar y editar calibradores.

Figura 28 Cuadro de diálogo Delta Mass Caliper Settings y ventana MS Spectrum Results

4 Borrar resultados de integración y 
espectros.

a Haga clic en Chromatograms > Clear 
Results > Include Peak Spectra.

b Haga clic en la herramienta Range 
Select.

• Si desea guardar los calibradores 
con los resultados del archivo de 
datos, consulte “Tarea 17. Guardar 
resultados” en la página 68.

Tarea 11. Añadir un calibrador de masa (continuación)

Pasos Instrucciones detalladas Comentarios
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Tarea 11. Añadir un calibrador de masa
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En estas tareas, aprenderá a identificar compuestos en archivos de 
datos GC/MS.

Cada ejercicio se presenta en una tabla con tres columnas:

• Pasos: utilice estas instrucciones generales para avanzar a su ritmo en la 
exploración del programa.

• Instrucciones detalladas: recurra a ellas si necesita ayuda o prefiere usar 
un proceso de aprendizaje paso a paso.

• Comentarios: léalos para aprender consejos e información adicional sobre 
cada paso de un ejercicio.
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Tarea 12. Encontrar compuestos por desconvulción de 
cromatograma

Este algoritmo FindCompounds identifica compuestos en datos GC/y crea un 
espectro MS limpio de cada compuesto. Esta función es una forma sencilla de 
“extraer” información a partir de datos complejos. Solo se puede usar el 
algoritmo Find Compounds by Chromatogram Deconvolution en datos GC/MS 
de muestra adquiridos en modo de barrido Scan, Product Ion scan o Neutral 
Loss.

Esta tarea muestra cómo encontrar compuestos por desconvolución de 
cromatograma con datos precisos de masa. También puede encontrar 
compuestos por desconvolución de cromatograma con datos unitarios de 
masa una vez que haya modificado previamente la ventana de extracción.

Tarea 12. Encontrar compuestos usando Chromatogram Deconvolution (GC/MS)

Paso Instrucciones detalladas Comentarios

1 Abra TIC desde el archivo de datos 
MSD_mix_4stds_DG_spl200_03.d.

a Si el programa no se abre, haga doble 
clic en el icono MassHunter 
Qualitative Analysis. También puede 
hacer clic en File > Open Data File.

b Haga clic en el archivo de datos 
MSD_mix_4stds_DG_spl200_03.d en 
la carpeta de archivos de datos de 
ejemplo GC.

c Desmarque la casilla de verificación 
Load result data y haga clic en Open.

• El algoritmo Find Compounds by 
Chromatogram Deconvolution 
funciona tanto con archivos de 
datos GC/QQQ como GC/Q-TOF.

Figura 29 Cromatograma TIC de Pest - 200 - Scan.d
48 Software MassHunter Workstation de Agilent - Guía de familiarización Qualitative Analysis para LC/MS



Buscar y encontrar 2
Tarea 12. Encontrar compuestos por desconvulción de cromatograma
2 Configurar la interfaz del usuario 
para utilizarla con datos GC/QQQ

• Siga las instrucciones indicadas en 
“Tarea 2. Configurar la interfaz de 
usuario para datos GC/MS” en la 
página 13.

• Para estos ejemplos, cargue el flujo 
de trabajo GC/Q-TOF Compound 
Screening.

3 Encontrar compuestos usando el 
algoritmo de desconvulción de 
cromatograma.
• Seleccione el integrador Agile.
• Indique un umbral SNR de 20.
• Introduzca 100 ppm en los 

valores Left m/z delta y Right 
m/z delta.

a En la ventana Method Explorer, 
seleccione Find Compounds > Find by 
Chromatogram Deconvolution.

b En la pestaña Settings de Peak filter, 
escriba 20 en SNR threshold.

c Seleccione PPM para m/z delta units.
d Introduzca 100 para Left m/z delta y 

escriba 100 para Right m/z delta.

• La sección Chromatogram 
Deconvolution también está 
disponible en la sección GC/Q-TOF 
Compound Screening.

• Si dispone de datos unitarios de 
masa, indique 0.3 AMU en el valor 
Left m/z delta y 0.7 AMU en el 
valor Right m/z delta

• Puede extraer el conjunto completo 
de resultados de un compuesto 
después de encontrarlo usando el 
elemento del menú Compounds > 
Extract Complete Result Set 
cuando un compuesto se encuentra 
resaltado.

Figura 30 Pestaña de la sección Find by Chromatogram Deconvolution

Tarea 12. Encontrar compuestos usando Chromatogram Deconvolution (GC/MS)

Paso Instrucciones detalladas Comentarios
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• Selecciónela para estraer EIC, 
espectros MS y espectros 
MS/MS.

e Haga clic en la pestaña Results.
f Marque las casillas de verificación 

Extract EIC, Extract ECC, Extract 
cleaned spectrum y Extract raw 
spectrum.

g Haga clic en  para ejecutar el 
algoritmo Find Compounds by 
Chromatogram Deconvolution del 
archivo de datos. 

h Si es necesario, haga clic en el 
comando View > Compound List.

• El programa Qualitative Analysis 
encuentra 4 compuestos en estas 
condiciones.

• Si el archivo de datos no está 
indezado, puede tardar mucho 
tiempo cuando ejecuta este 
algoritmo.

4 Examine los compuestos. Consulte 
Figura 31 en la página 51.

a Seleccione 2 en el recuadro Maximum 
number of list panes de la barra de 
herramientas MS Spectrum Results.

b Haga clic en el icono Hide Empty 
Columns de la ventana Compound List.

c Haga clic en el primer compuesto de la 
ventana Data Navigator. 

d Cuando se selecciona la ventana Data 
Navigator, utilice las teclas de 
navegación para cambiar de 
compuesto. 

• Mostrar ambos espectros es una 
forma cómoda de visualizar toda la 
infromación de un único compuesto.

• Nótese que se muestran tanto el 
espectro limpio como el espectro sin 
procesar.

Tarea 12. Encontrar compuestos usando Chromatogram Deconvolution (GC/MS)

Paso Instrucciones detalladas Comentarios
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Figura 31 Resultados de Find Compounds by Chromatogram Deconvolution

Tarea 12. Encontrar compuestos usando Chromatogram Deconvolution (GC/MS)
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Tarea 13. Identificar compuestos usando el algoritmo Search Library

En esta tarea, identificará y generará fórmulas para los compuestos que 
encontrará en “Tarea 12. Encontrar compuestos por desconvulción de 
cromatograma” en la página 48. Puede realizar esta tarea si ha adquirido la 
biblioteca NIST08.l o si utiliza la biblioteca demo.l. Si dispone de dos 
bibliotecas, puede seleccionar ambas.

Tarea 13. Identificar compuestos usando el algoritmo Search Library

Paso Instrucciones detalladas Comentarios

1 Realice una búsqueda de biblioteca 
de todos los compuestos del 
archivo de datos 
MSD_mix_4stds_DG_spl200_03.d.

a Resaltar los compuestos del archivo 
de datos 
MSD_mix_4stds_DG_spl200_03.D en 
la ventana Data Navigator.

b En la ventana Method Explorer, haga 
clic en Identify Compounds > Search 
Unit Mass Library.

c En la pestaña Settings, haga clic en el 
botón Add Library. Seleccione la 
biblioteca demo.l y haga clic en el 
botón OK.

d (opcional) En la pestaña Settings, haga 
clic en el botón Add Library. 
Seleccione la biblioteca NIST08.l y 
haga clic en el botón OK.

e Haga clic en la pestaña Search Results.
f (opcional) Seleccione Stop When 

Found como Multi-Library search type.
g Haga clic en Identify > Search Library 

for Compounds en el menú principal. 
También puede hacer clic en Search 
Library for Compounds, icono , 
para ejecutar el algoritmo.

h Haga clic en View > Difference Results.
i Haga clic en View > Structure Viewer.
j Haga clic en View > Compound 

Identification Results si es necesario 
para ver esta ventana.

k Si es necesario, haga clic en la 
pestaña de la ventana Compound 
Identification Results. Esta ventana 
está tabulada con la ventana 
Chromatogram Results.

• También puede hacer clic en 
GC/Q-TOF Compound Screening > 
Identify by Library Search en 
Method Explorer. También se 
muestra la misma sección de la 
ventana Method Editor.

• Demo.l y Nist08 deben instalarse en 
la carpeta \MassHunter\Library.

• Nótese que muchos de los 
compuestos se identifican después 
de buscar la biblioteca NIST08.l.

• Si no dispone de la biblioteca 
NIST08.l, seleccione una segunda 
biblioteca si dispone de ella.

• Si selecciona dos o más bilbiotecas 
y después selecciona Stop When 
Found, el algoritmo de búsqueda de 
bibliotecas busca la primera de la 
lista. Si se identifica el compuesto, 
se detiene. Si no se identifica el 
compuesto, busca la siguiente 
biblioteca hasta identificar el 
compuesto o hasta terminar de 
buscar en la última biblioteca.

• Utilice el programa Library Editor 
para modificar aquellas bibliotecas 
que utiliza con el algoritmo Search 
Unit Mass Library. El programa se 
instala junto con el programa 
Agilent MassHunter Quantitative 
Analysis. Haga clic en el icono 

 para iniciar este programa.
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2 Columnas Display the Spectral 
Library Results de la ventana 
Compound List window y la 
ventana Compound Identification 
Results. 

a Haga clic en el botón Show Library 
Search Columns ( ) de la barra de 
herramientas Compound List y en la 
barra de herramientas Compound 
Identification Results.

b Haga clic en el botón Hide Empty 
Columns button ( ) de la barra de 
herramientas Compound List y en la 
ventana Compound Identification 
Results.

Figura 32 Compuestos del archivo de datos MSD_mix_4stds_DG_spl200_03.D y resultados de búsqueda de 
biblioteca

Tarea 13. Identificar compuestos usando el algoritmo Search Library
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3 Cambie a Compound Details View 
para revisar los compuestos.

a Haga clic en , en 
la barra de herramientas principal.

b Cierre la ventana Compound Fragment 
Spectrum Results.

4 Revise los resultados en 
Compound Details View.

a Haga clic en el icono Overlaid de la 
ventana Compound Chromatogram 
Results.

b Amplíe los resultados en la ventana 
Compound Identification Results.

• Puede ampliar información acerca 
de Compound Details View en la 
Ayuda en línea. Compound Details 
View es muy útil cuando revisa los 
resultados del algoritmo Find by 
Formula con un archivo de datos 
adquirido en modo All Ions.

Figura 33 Compound Details View mostrando compuestos en el archivo de datos 
MSD_mix_4stds_DG_spl200_03.D

Tarea 13. Identificar compuestos usando el algoritmo Search Library

Paso Instrucciones detalladas Comentarios
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5 Volver a Navigator View. • Haga clic en el botón 
 de la barra de 

herramientas principal.

6 Cierre el archivo de datos. a Haga clic en File > Open Data File.
b Haga clic en No.

• Si desea guardar los resultados, 
consulte “Tarea 17. Guardar 
resultados” en la página 68.

Tarea 13. Identificar compuestos usando el algoritmo Search Library

Paso Instrucciones detalladas Comentarios
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Tarea 14. Encontrar compuestos por MRM (solo MRM)

El algoritmo Find Compounds by MRM identifica compuestos en datos MRM a 
partir de un cuadrupolo triple. El algoritmo busca compuestos usando las 
transiciones MRM. Todos los compuestos del método de adquisición se extraen 
y muestran en Compound List. Los compuestos no se eliminan en función de 
los resultados de integración del cromatograma. También puede usar solo el 
algoritmo Find Compounds by MRM en datos adquiridos usando transiciones 
MRM. El algoritmo MRM utiliza información que se encuentra en el archivo de 
datos, cuando se trata de un archivo de datos MRM.

Tarea 14. Encontrar compuestos usando MRM (solo MRM)

Paso Instrucciones detalladas Comentarios

1 Abra el TIC del archivo de datos 
Pest - STD 200 MRM.d.

a Si el programa no se abre, haga doble 
clic en el icono MassHunter 
Qualitative Analysis. También puede 
hacer clic en File > Open Data File.

b Haga clic en el archivo de datos Pest - 
STD 200 MRM.d de la carpeta de 
archivo de datos de ejemplo GC.

c Desmarque la casilla de verificación 
Load result data y haga clic en Open.

• Cuando se trabaja con datos 
GC/QQQ se utiliza General 
Workflow. Puede utilizar General 
Workflow o el flujo de trabajo 
GC/Q-TOF Compound Screening al 
trabajar con datos GC/Q-TOF.

Figura 34 Cromatograma TIC de Pest - STD 200 MRM.d

2 Configurar la interfaz del usuario 
para utilizarla con datos GC/QQQ

• Siga las instrucciones indicadas en 
“Tarea 2. Configurar la interfaz de 
usuario para datos GC/MS” en la 
página 13.
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3 Encontrar compuestos usando el 
algoritmo MRM.

a En la ventana Method Explorer, 
seleccione Find Compounds > Find by 
MRM.

b Haga clic en el botón Group 
transitions by compound name.

c Haga clic en la pestaña Integrator.
d Seleccione el integrador Agile.

• Puede elegir la región del 
cromatograma desde la que desea 
encontrar compuestos. 

• Puede extraer el conjunto completo 
de resultados de un compuesto 
después de encontrarlo usando el 
elemento del menú Compounds > 
Extract Complete Result Set 
cuando un compuesto se encuentra 
resaltado.

Figura 35 Pestaña Integrator en la sección Find by MRM de Method Editor

e Haga clic en  para ejecutar el 
algoritmo Find Compounds by MRM 
del archivo de datos. 

f Si es necesario, haga clic en el 
comando View > Compound List.

g Si es necesario, haga clic en el 
comando View > Compound 
Identification Results.

• El programa Qualitative Analysis 
encuentra 28 compuestos en estas 
condiciones.

Tarea 14. Encontrar compuestos usando MRM (solo MRM)
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4 Examine los compuestos. Consulte 
Figura 36 en la página 58.

a Seleccione 2 en el recuadro Maximum 
number of list panes de la barra de 
herramientas MS Spectrum Results.

b Haga clic en el icono Automatically 
Show Columns de la ventana 
Compound List y en la ventana 
Compound Identification Results.

c Haga clic en el primer compuesto de la 
ventana Data Navigator. 

d Cuando se selecciona la ventana Data 
Navigator, utilice las teclas de 
navegación para cambiar de compuesto. 

• El ion precursor se muestra en la 
columna Precursor (Acq Method) y 
el ion del producto se muestra en la 
columna Product (Acq Method) de 
la ventana Compound Identification 
Results.

Figura 36 Encontrar por resultados MRM

Tarea 14. Encontrar compuestos usando MRM (solo MRM)

Paso Instrucciones detalladas Comentarios
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5 Cierre el archivo de datos. a Haga clic en File > Open Data File.
b Haga clic en Close.

• Si desea guardar los resultados, 
consulte “Tarea 17. Guardar 
resultados” en la página 68.

Tarea 14. Encontrar compuestos usando MRM (solo MRM)
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Tarea 15. Encontrar compuestos por Integración

El algoritmo Find Compounds by Integration identifica compuestos basándose 
en los resultados de integración. Se crea un compuesto por cada pico que 
identifica el integrador.

Tarea 15. Encontrar compuestos usando Integración

Paso Instrucciones detalladas Comentarios

1 bra TIC desde el archivo de datos 
MSD_mix_4stds_DG_spl200_03.D.

a Si el programa no se abre, haga doble 
clic en el icono MassHunter 
Qualitative Analysis. También puede 
hacer clic en File > Open Data File.

b Haga clic en el archivo de datos Pest - 
STD 200 MRM.d de la carpeta de 
archivo de datos de ejemplo GC.

c Desmarque la casilla de verificación 
Load result data y haga clic en Open.

• Cuando se trabaja con datos 
GC/QQQ se utiliza General 
Workflow. Puede utilizar General 
Workflow o el flujo de trabajo 
GC/Q-TOF Compound Screening al 
trabajar con datos GC/Q-TOF.

Figura 37 TIC chromatogram from MSD_mix_4stds_DG_spl200_03.d

2 Configurar la interfaz del usuario 
para utilizarla con datos GC/QQQ

• Siga las instrucciones indicadas en 
“Tarea 2. Configurar la interfaz de 
usuario para datos GC/MS” en la 
página 13.

3 Encontrar compuestos usando el 
algoritmo de integración.

a En la ventana Method Explorer, 
seleccione Find Compounds > Find by 
Integration.

b Seleccione el integrador MS/MS (GC).

• Puede elegir la región del 
cromatograma desde la que desea 
encontrar compuestos. 

• Puede extraer el conjunto completo 
de resultados de un compuesto 
después de encontrarlo usando el 
elemento del menú Compounds > 
Extract Complete Result Set 
cuando un compuesto se encuentra 
resaltado.
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Figura 38 Pestaña Integrator en la sección Find by Integration de Method Editor

c Haga clic en  para ejecutar el 
algoritmo Find Compounds by 
Integration del archivo de datos. 

d Si es necesario, haga clic en el 
comando View > Compound List.

• El programa Qualitative Analysis 
encuentra 6 compuestos en estas 
condiciones.

4 Examine los compuestos. Consulte 
Figura 36 en la página 58.

a Seleccione 2 en el recuadro Maximum 
number of list panes de la barra de 
herramientas MS Spectrum Results.

b Haga clic en el icono Automatically 
Show Columns de la ventana 
Compound List.

c Haga clic en el primer compuesto de la 
ventana Data Navigator. 

d Cuando se selecciona la ventana Data 
Navigator, utilice las teclas de 
navegación para cambiar de compuesto. 

Tarea 15. Encontrar compuestos usando Integración
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Figura 39 Resultados de Find by Integration

5 Cierre el archivo de datos. a Haga clic en File > Open Data File.
b Haga clic en Close.

• Si desea guardar los resultados, 
consulte “Tarea 17. Guardar 
resultados” en la página 68.

Tarea 15. Encontrar compuestos usando Integración

Paso Instrucciones detalladas Comentarios
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Tarea 16. Generar fórmulas y bibliotecas de búsqueda para 
espectros de pico

En esta tarea, primero se integran y extraen los espectros de pico desde un 
archivo de datos GC/Q-TOF. Seguidamente, se generan posibles fórmulas para 
cada uno de los espectros de pico.

Tarea 16. Generar fórmulas y bibliotecas de búsqueda para espectros de pico

Paso Instrucciones detalladas Comentarios

1 Abra el TIC desde el archivo de datos 
MSD_mix_4stds_DB_spl200_03.d.

a Si el programa no se abre, haga doble 
clic en el icono MassHunter 
Qualitative Analysis. También puede 
hacer clic en File > Open Data File.

b Haga clic en el archivo de datos 
MSD_mix_4stds_DB_spl200_03.d en 
la carpeta de archivos de datos de 
ejemplo GC.

c Desmarque la casilla de verificación 
Load result data y haga clic en Open.

• Si la casilla de verificación Load 
result data no está disponible, no 
se han guardado los resultados en 
el archivo de datos. Consulte “Tarea 
17. Guardar resultados” en la 
página 68 para obtener 
instrucciones sobre cómo guardar 
los resultados.

2 Integrar y extraer espectros de 
picos.

a Haga clic en la sección Chromatogram 
> Integrate (MS/MS) en la ventana 
Method Explorer.

b Haga clic en la pestaña Peak Filters.
c Haga clic en el botón Peak height.
d Marque la casilla de verificación 

Relative height.
e Marque la casilla de verificación Limit 

(by height) to the largest y escriba 4.
f Haga clic en Chromatograms > 

Integrate and Extract Peak Spectra.
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3 Generar fórmulas para cada 
espectro de picos.
• Visualizar la lista Spectrum 

Identification Results List.
• Cierre la ventana MS Spectrum 

Results.

Sugerencia: Para obtener los mismos 
resultados que en Figura 41, 
asegúrese de que ha seleccionado 
Common organic molecules como 
modelo Isotope.

a En la ventana Method Explorer, haga 
clic en Identify Compounds > 
Generate Formulas.

b En la ventana Method Editor, haga clic 
en la pestaña Charge State y 
seleccione Common organic 
molecules como modelo Isotope.

c En la ventana Data Navigator, resalte 
todos los espectros de la sección User 
Spectra.

d Haga clic en el comando Identify > 
Generate Formulas from Spectrum 
Peaks o el botón Generate Formulas 
from Spectrum Peaks  para 
ejecutar el algoritmo.

e Si es necesario, haga clic en el icono 
Spectrum Identification Results, , 
o haga clic en el comando View > 
Spectrum Identification Results.

f En la ventana Spectrum Identification 
Results, haga clic en el botón 
Automatically Show Columns de la 
barra de tareas.

g Haga clic en el icono Hide Empty 
Columns, , en la ventana Spectrum 
Identification Results.

h Seleccione C6 H13 como resultado 
Best.

i Amplíe la tabla en dicha fila.
j Cierre la ventana Method Editor.
k Revise Formula e Ion Species, que 

aparecen sobre gran parte de los picos 
en la ventana MS Spectrum Results. 
Todas las Formula e Ion Species tienen 
el mismo color que el espectro.

• Puede ver la predicción de índices 
de abundancia de isótopos en las 
líneas de espectro cuando amplía la 
imagen en el m/z apropiado. 
Consulte la Ayuda en línea para 
obtener más información.

• El icono Run  de la barra de 
herramientas Method Editor en 
ocasiones le permite elegir una 
acción a partir de un conjunto de 
acciones posibles. Por ejemplo, al 
pulsar el icono Run de esta sección 
disponemos de dos acciones 
diferentes. Si pulsa la flecha, se 
muestra una lista de posibles 
acciones y puede elegir qué acción 
realizar. Si elije una acción distinta 
de la lista, la acción por defecto 
cambia. Si simplemente hace clic en 
el botón Run, se lleva a cabo la 
acción por defecto.

• Puede cambiar la anchura de una 
columna arrastrando la línea que 
separa las columnas adyacentes.

• Puede desplazar una columna 
arrastrando el encabezado de dicha 
columna.

• Puede borrar una columna haciendo 
clic en Remove column en el menú 
de acceso directo de la tabla.

Tarea 16. Generar fórmulas y bibliotecas de búsqueda para espectros de pico
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Figura 40 Generar resultados de Fórmula para los picos 1 a 4

4 Realizar una búsqueda 
de biblioteca para espectros 
de pico 1 a 4.

a En la ventana Data Navigator, haga clic 
en User Spectra.

b En la ventana Method Explorer, haga 
clic en Identify Compounds > Search 
Unit Mass Library.

c Compruebe que ha seleccionado una 
biblioteca válida.

d Haga clic en Identify > Search Library 
for Spectra en el menú principal.

e Cierre la ventana Method Editor.

• Method Editor se abre 
automáticamente cuando se hace 
clic en una sección de Method 
Explorer.

Tarea 16. Generar fórmulas y bibliotecas de búsqueda para espectros de pico
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5 Modifique las columnas que 
quedan visibles.

a Haga clic con el botón derecho en la 
ventana Spectrum Identification 
Results y haga clic en Add/Remove 
Columns. En el cuadro de diálogo 
“(Enhanced) Add/Remove Columns”, 
marque las columnas que desea 
visualizar. Haga clic en OK.

b Cierre la ventana Method Editor
c Haga clic en el icono Hide Empty 

Columns, , en la ventana Spectrum 
Identification Results.

d Revise Formula & Ion Species, que 
aparece sobre cada pico en la ventana 
MS Spectrum Results.

• Si visualiza el comando Remove 
Column y elimina una columna que 
contiene datos, el software vuelve a 
mostrar automáticamente esta 
columna si la función Automatically 
Show Columns está activada.

• El algoritmo LibSearch está 
fuertemente ponderado en la 
sección Combine Identification 
Results del método. Puede elegir 
manualmente el mejor resultado 
MFG o cambiar la manera en que se 
combinan los resultados de 
identificación.

Figura 41 Resultados de Library Search and Generate Formulas para el primer espectro de picos

Tarea 16. Generar fórmulas y bibliotecas de búsqueda para espectros de pico
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6 Revise los resultados de cada 
espectro en la ventana MS Peaks 
One.

a Haga clic en View >MS Spectrum 
Peak List 1.

b Haga clic con el botón derecho y pulse 
Add/Remove Columns.

c Compruebe que las columnas 
mostradas en Figura 42 se 
encuentran en la lista Show these 
columns.

d Realice una clasificación por columna 
Ion Type.

e Si Ion Type es Fragment Ion, Formula & 
Ion Species se mostrará en verde en 
cada pico de la ventana MS Spectrum 
Results.

• Los iones fragmentados se 
muestran en verde en la ventana 
MS Spectrum Results.

• Ion Type puede ser Molecular Ion, 
Fragment Ion o dejarse en blanco. Si 
es Fragment Ion, las columnas Loss 
Formula y Loss Mass muestran la 
Formula y Masa con las que se 
obtiene dicho ion a partir de 
Molecular Ion. Formula & Ion 
Species muestra la fórmula y 
especie iónica correspondientes a 
dicho ion.

Figura 42 Tabla MS Peaks One con columnas Ion Type, Loss Formula, Loss Mass, 
y Formula & Ion Species

7 (opcional) Cierre el archivo de 
datos.
• Puede avanzar a la sigiuente 

tarea para aprender a guardar 
resultados.

a Haga clic en File > Open Data File.
b Haga clic en Close.

• Si desea guardar los resultados, 
consulte “Tarea 17. Guardar 
resultados” en la página 68.

Tarea 16. Generar fórmulas y bibliotecas de búsqueda para espectros de pico

Paso Instrucciones detalladas Comentarios
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Tarea 17. Guardar resultados
Tarea 17. Guardar resultados

En esta tarea aprenderá a guardar los resultados del archivo actual de datos.

Tarea 17. Guardar resultados

Paso Instrucciones detalladas Comentarios

1 Guarde los resultados del archivo 
actual de datos y cierre el archivo 
de datos.

a Haga clic en File > Save Results.
b Haga clic en File > Open Data File.

• Solo puede guardar un conjunto de 
resultados en un archivo de datos. 
Si ya ha guardado los resultados 
con el archivo de datos actual, 
dichos resultados se sobrescribirán 
al hacer clic en File > Save Results.

2 Abra el archivo de datos y cargue 
los resultados.

a Haga clic en File > Open Data File. Se 
abrirá el cuadro de diálogo “Open Data 
File”.

b Seleccione un archivo de datos. En 
este ejemlo, seleccione el archivo de 
datos 
MSD_mix_4stds_DG_spl200_03.d.

c Marque la casilla de verificación Load 
result data.

d Haga clic en el botón Open.
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Tarea 17. Guardar resultados
Figura 43 Abra el cuadro de diálogo Data File

3 Examine los resultados. a Haga clic en la ventana Spectrum 
Identification Results.

b Revise los resultados.

•

Tarea 17. Guardar resultados

Paso Instrucciones detalladas Comentarios

Se marcará la casilla de verificación Load result data.
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Tarea 17. Guardar resultados
Figura 44 Resultados de Library Search and Generate Formulas para el primer espectro de picos

4 Cierre el archivo de datos. a Haga clic en File > Open Data File.
b Haga clic en Close.

5 Vuelva a abrir el archivo de datos y 
no cargue los resultados.

a Haga clic en File > Open. Se abrirá el 
cuadro de diálogo “Open Data File”.

b Seleccione un archivo de datos. En 
este ejemlo, seleccione el archivo de 
datos 
MSD_mix_4stds_DG_spl200_03.d.

c Marque la casilla de verificación Load 
result data.

d Haga clic en el botón Open.

• Si no carga resultados, se abrirá por 
defecto un TIC al abrir un archivo de 
datos. Si marca las acciones Run de 
‘File Open’ en la casilla de 
verificación del método 
seleccionado, se ejecutarán las 
acciones File Open. Consulte la 
ayuda en línea para obtener más 
información.

Tarea 17. Guardar resultados

Paso Instrucciones detalladas Comentarios
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Tarea 17. Guardar resultados
Figura 45 Resultados de Library Search and Generate Formulas para el primer espectro de picos

6 Cierre el archivo de datos. a Haga clic en File > Open Data File.
b Haga clic en Close.

Tarea 17. Guardar resultados

Paso Instrucciones detalladas Comentarios
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Tarea 17. Guardar resultados
72 Software MassHunter Workstation de Agilent - Guía de familiarización Qualitative Analysis para LC/MS



Software MassHunter Workstation de Agilent Qualitative Analysis
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Utilizar flujos de trabajo, exportación e 
impresión

Tarea 18. Configurar y ejecutar un método de análisis cualitativo usando el 
flujo de trabajo general 74

Tarea 19. Configure y ejecute un método mediante el flujo de trabajo 
GC/Q-TOF Compound Screening 79

Tarea 20. Exportar un archivo CEF 83

Tarea 21. Imprimir un informe de análisis 85

Tarea 22. Imprimir un informe compuesto 88

En estas tareas, aprenderá a configurar y ejecutar un método de análisis 
cualitativo. Después, podrá ejecutar las acciones de este método automatizado 
al abrir un archivo de datos. 

En estos ejemplos se utilizan dos flujos de datos distintos. Consulte “Flujos de 
trabajo” en la página 100 para obtener más información.

El flujo de datos General admite datos GC/QQQ, GC/Q-TOF y LC/MS. El flujo 
de trabajo GC/Q-TOF Compound Screening admite datos GC/Q-TOF.

Cada ejercicio se presenta en una tabla con tres columnas:

• Pasos: utilice estas instrucciones generales para avanzar a su ritmo en la 
exploración del programa.

• Instrucciones detalladas: recurra a ellas si necesita ayuda o prefiere usar 
un proceso de aprendizaje paso a paso.

• Comentarios: léalos para aprender consejos e información adicional sobre 
cada paso de un ejercicio.
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Tarea 18. Configurar y ejecutar un método de análisis cualitativo usando el flujo de trabajo general
Tarea 18. Configurar y ejecutar un método de análisis cualitativo 
usando el flujo de trabajo general

Cuando comienza a usar el programa Qualitative Analysis, se carga el método 
default.m. Puede realizar cambios en el método abierto y guardarlo, o bien 
abrir un nuevo método, realizar cambios y guardar dicho método. No es 
posible sobreescribir el método default.m.

También puede realizar una configuración para ejecutar acciones concretas en 
el método al abrir un archivo de datos. Al abrir un archivo de datos, también 
puede cargar el método que se empleó para crear los resultados que se 
almacenan con el archivo de datos. El método se guarda automáticamente al 
guardar los resultados con el archivo de datos. El flujo de trabajo General 
puede utilizarse con archivos de datos GC/MS o LC/MS.

Tarea 18. Configurar y ejecutar un método de análisis cualitativo usando el flujo de trabajo general

Pasos Instrucciones detalladas Comentarios

1 Abra el TIC del archivo de datos 
Pest - STD 200 MRM.d.

a Si el programa no se abre, haga doble 
clic en el icono MassHunter 
Qualitative Analysis. También puede 
hacer clic en File > Open Data File.

b Haga clic en el archivo de datos Pest - 
STD 200 MRM.d de la carpeta de 
archivo de datos de ejemplo GC.

c Desmarque la casilla de verificación 
Load result data y haga clic en Open.

• Puede utilizar General Workflow o 
el flujo de trabajo GC/Q-TOF 
Compound Screening al trabajar 
con datos GC/MS.

2 Configurar la interfaz del usuario 
para utilizarla con datos GC/QQQ

• Siga las instrucciones indicadas en 
“Tarea 2. Configurar la interfaz de 
usuario para datos GC/MS” en la 
página 13.

• En este ejemplo, seleccione el flujo 
de trabajo General.

3 Configure el método para extraer 
un cromatograma TIC. 
• Defina un cromatograma TIC 

para datos MS.

a Desde la ventana Method Explorer, 
seleccione Chromatogram > Define 
Chromatograms.

b Elimine el cromatograma BPC.
c Seleccione TIC como Type.
d Asegúrese de que el nivel MS es 

MS/MS.
e Haga clic en Add.
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Tarea 18. Configurar y ejecutar un método de análisis cualitativo usando el flujo de trabajo general
4 Edite el método para integrar los 
datos.
• Limite la integración a los cuatro 

picos más altos.

a Desde la ventana Method Explorer, 
seleccione Chromatogram > 
Integrate (MS/MS).

b Haga clic en la pestaña Peak Filters.
c En la sección Maximum number of 

peaks section, marque la casilla de 
verificación Limit (by height) to the 
largest.

d Escriba 4. 

• Si actualiza un valor en la pestaña 
Peak Filters de la sección 
Chromatogram > Integrate (MS), 
también se actualizarán los valores 
de las demás secciones de Method 
Explorer. Aparecerán triángulos 
azules para mostrar estas otras 
secciones.

Figura 46 Pestaña Chromatogram > Integrate (MS/MS) > Peak Filters 

5 Prueba la integración para 
asegurarse de que solo aparecen 4 
picos integrados.

• Haga clic en el icono Integrate 
Chromatogram, , para integrar el 
archivo de datos. 

6 Guarde el método en 
iii_GCexercise1, donde “iii” son 
sus iniciales.

a Desde el menú superior, haga clic en 
Method > Save As.

b Escriba iii_GCexercise1.
c Haga clic en el botón Save.

• Nótese que al guardar el método 
todos los triángulos azules que 
incidan cambios de valor en el 
método abierto desaparecen.

7 Cambie el fondo del espectro de 
pico para utilizar el espectro al 
inicio del pico.

a Desde la ventana Method Explorer, 
seleccione Spectrum > Extract 
(MS/MS).

b Haga clic en Peak Spectrum 
Extraction (MS/MS).

c Para el fondo del espectro de pico, 
seleccione Spectrum at peak start.

• Si realiza cualquier cambio 
adicional después de guardar el 
método, se añadirán los triángulos 
azules.

Tarea 18. Configurar y ejecutar un método de análisis cualitativo usando el flujo de trabajo general

Pasos Instrucciones detalladas Comentarios

Puede hacer clic en el icono 
Save Method para guardar el 
método actual.
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Figura 47 Pestaña The Spectrum > Extract (MS/MS) > Peak Spectrum Extraction (MS/MS) 

8 Pruebe la extracción del espectro 
MS para asegurarse de restar el 
espectro de fondo.

• Haga clic en el icono Extract Peak 
Spectrum, , para ejecutar la acción 
del pico seleccionado en el archivo de 
datos. 

9 Guarde el método. • Guarde el método siguiendo uno de 
estos tres métodos:
• Haga clic en el icono Save 

Method de Method Editor
• Haga clic con el botón 

derecho en Method Editor, y pulse 
Save Method.

• Desde el menú superior, haga clic en 
Method > Save.

• Se mostrará el icono Save Method 
en Figura 47 en la página 76

10 Configure el método para 
automatizar las acciones cuyos 
parámetros acaba de modificar al 
abrir un archivo de datos.
• Liste las acciones que se 

realizarán al abrir este u otro 
archivo de datos.

Sugerencia: mire General en Method 
Explorer.

a Desde la ventana Method Explorer, 
seleccione General > File Open 
Actions.

b Seleccione Integrate and Extract 
Peak Spectra desde la lista Available 
actions. 

c Haga clic en el botón Add, , 
mara mover la acción seleccionada a 
la lista Actions to be run. 
También puede hacer doble clic en la 
acción seleccionada para desplazarla a 
la otra lista.

Tarea 18. Configurar y ejecutar un método de análisis cualitativo usando el flujo de trabajo general

Pasos Instrucciones detalladas Comentarios

Puede hacer clic en el icono 
Save Method para guardar el 
método actual.
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Tarea 18. Configurar y ejecutar un método de análisis cualitativo usando el flujo de trabajo general
11 Pruebe las acciones de File Open. • Haga clic en el icono Run File Open 
Actions Now, , para ejecutar las 
acciones del archivo de datos. 

• Los cromatogramas y espectros no 
se sobreescriben. Se añaden 
nuevos cromatogramas y espectros.

Figura 48 Sección General > File Open Actions en Method Editor

12 Guarde el método. • Haga clic en el icono Save Method de 
la ventana Method Editor,

13 Configure el método para 
automatizar las acciones al 
ejecutar el método durante una 
lista de trabajo.
• Liste las acciones que se 

realizarán al abrir este u otro 
archivo de datos.

Sugerencia: Mire Worklist Automation 
en la ventana Method Explorer

a Desde la ventana Method Explorer, 
seleccione Worklist Automation > 
Worklist Actions.

b Elimine Generate Analysis Report de 
la lista Actions to be run.

14 Pruebe Worklist Actions. • Haga clic en el icono Run Worklist 
Actions Now, , para ejecutar las 
acciones del archivo de datos. 

• Los cromatogramas y espectros no 
se sobreescriben. Se añaden 
nuevos cromatogramas y espectros.

Tarea 18. Configurar y ejecutar un método de análisis cualitativo usando el flujo de trabajo general

Pasos Instrucciones detalladas Comentarios

Dos acciones distintas forman 
parte de la lista Actions to be run. 
La primera acción consiste en 
extraer los cromatogramas 
definidos. Seguidamente, dicho 
cromatograma se integra y se 
extraen los picos.
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Tarea 18. Configurar y ejecutar un método de análisis cualitativo usando el flujo de trabajo general
Figura 49 Sección Worklist Automation > Worklist Actions en Method Editor

15 Guarde el método y cierre el 
archivo de datos sin guardar los 
resultados.

a Haga clic en el icono Save Method de 
Method Editor,

b Haga clic en File > Close Data File, y 
haga clic en No cuando se le pida 
guardar los resultados.

Tarea 18. Configurar y ejecutar un método de análisis cualitativo usando el flujo de trabajo general

Pasos Instrucciones detalladas Comentarios

En un método se incluyen dos 
listas distintas de acciones. La 
primera lista de acciones (File 
Open Actions) puede ejecutarse 
al abrir un archivo de datos. La 
segunda lista de acciones 
(Worklist Actions) se ejecuta al 
ejecutar el método.
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Tarea 19. Configure y ejecute un método mediante el flujo de trabajo GC/Q-TOF Compound Screening
Tarea 19. Configure y ejecute un método mediante el flujo de trabajo 
GC/Q-TOF Compound Screening

En esta tarea se configura un método de análisis cualitativo que contiene una 
lista de acciones de análisis que se ejecutarán en un orden concreto. Entre 
otros, se incluye la extracción e integración de cromatogramas, extracción de 
espectros, búsqueda de espectros de pico en una biblioteca, generación de 
fórmulas para espectros e impresión de un informe de análisis.

Tarea 19. Configure y ejecute un método mediante el flujo de trabajo GC/Q-TOF Compound Screening

Pasos Instrucciones detalladas Comentarios

1 Abra TIC desde el archivo de datos 
MSD_mix_4stds_DG_spl200_03.d
.

a Si el programa no se abre, haga doble 
clic en el icono MassHunter 
Qualitative Analysis. También puede 
hacer clic en File > Open Data File.

b Haga clic en el archivo de datos 
MSD_mix_4stds_DG_spl200_03.d en 
la carpeta de archivos de datos de 
ejemplo GC.

c Desmarque la casilla de verificación 
Load result data y haga clic en Open.

2 Configurar la interfaz del usuario 
para utilizarla con datos GC/QQQ

• Siga las instrucciones indicadas en 
“Tarea 2. Configurar la interfaz de 
usuario para datos GC/MS” en la 
página 13.

• Para este ejemplo, cargue el flujo de 
trabajo GC/Q-TOF Compound 
Screening.

3 Asegúrese de extraer un TIC. a Desde la ventana Method Explorer, 
seleccione Chromatogram.

b Haga clic en la sección Define 
Chromatograms.

c En la ventana Method Editor, 
compruebe que el cromatograma de la 
sección Defined chromatograms es 
un TIC. En caso contrario, seleccione 
TIC como Type. Haga clic en el botón 
Change.

•
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4 Revise los parámetros 
correspondientes al algoritmo Find 
by Chromatogram Deconvolution.

a Haga clic en la sección GC/Q-TOF 
Compound Screening > Find by 
Chromatogram Deconvolution en la 
ventana Method Explorer.

b Haga clic en la pestaña Mass Filters.
c Ajuste el valor Absolute height a 

13000.
d Haga clic en la pestaña Results.
e Haga clic en el botón Highlight all 

compounds.
f Revise los resultados en cada pestaña.

• Mire las secciones del flujo de 
trabajo GC/Q-TOF Compound 
Screening.

• Tenga en cuenta las seis secciones 
de este flujo de trabajo. Todas estas 
secciones son duplicados de 
secciones que ya forman parte del 
explorador de métodos.

• Tenga en cuenta que aparecen 
triángulos azules en otras 
secciones de Method Explorer. 
Indican que los mismos valores del 
parámetro también se han 
cambiado en otros lugares.

5 Revise los parámetros 
correspondientes al algoritmo 
Identify by Library Search.

a Haga clic en la sección GC/Q-TOF 
Compound Screening > Identify by 
library search en la ventana Method 
Explorer.

b Haga clic en el botón Add Library. 
Seleccione una librería y haga clic en 
Open.

c (opcional) Haga clic en el botón 
Remove Library para eliminar una 
biblioteca si no desea utilizarla.

d Revise los parámetros de cada 
pestaña.

• Se instala la biblioteca demo.l 
library o NIST08.l (u otra versión de 
la biblioteca NIST) en la carpeta 
\MassHunter\Library.

6 Guarde el método en 
iii_GCexercise2, donde “iii” son 
sus iniciales.

a Desde el menú superior, haga clic en 
Method > Save As.

b Escriba iii_GCexercise2.
c Haga clic en el botón Save.

Tarea 19. Configure y ejecute un método mediante el flujo de trabajo GC/Q-TOF Compound Screening

Pasos Instrucciones detalladas Comentarios
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7 Configure el método para 
automatizar las acciones al abrir un 
archivo de datos.
• Liste las acciones que se 

realizarán al abrir este u otro 
archivo de datos.

Sugerencia: Mire General en la 
ventana Method Explorer

a Desde la ventana Method Explorer, 
seleccione General > File Open 
Actions.

b Elimine Generate Analysis Report de 
la lista Actions to be run.

c Elimine Integrate and Extract Peak 
Spectra.

d Elimine cualquier otra acción de la 
lista.

e Añada Extract Defined 
Chromatograms.

f Añada Find Compounds by 
Chromatogram Deconvolution.

g Añada Search Spectral Library for 
Compound.

8 Pruebe las acciones de File Open. • Haga clic en el icono Run File Open 
Actions Now, , para ejecutar las 
acciones del archivo de datos. 

• Los cromatogramas y espectros no 
se sobreescriben. Se añaden 
nuevos cromatogramas y espectros.

Tarea 19. Configure y ejecute un método mediante el flujo de trabajo GC/Q-TOF Compound Screening

Pasos Instrucciones detalladas Comentarios
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Figura 50 Resultados de las acciones de ejecutar una lista de trabajos en los datos GC/Q-TOF

9 Guarde el método en 
iii_GCexercise2, donde “iii” son 
sus iniciales.

a Desde el menú, haga clic en Method > 
Save As.

b Escriba iii_GCexercise2.
c Haga clic en Save.

• Si este método se ejecuta usando 
una lista de trabajo de Data 
Acquisition, Worklist Actions de 
esta pestaña se ejecutarán en el 
orden determinado.

10 Cierre el archivo de datos sin 
guardar los resultados.

a Haga clic en File > Open Data File.
b Haga clic en No cuando se le pregunte 

si desea guardar los resultados.

Tarea 19. Configure y ejecute un método mediante el flujo de trabajo GC/Q-TOF Compound Screening

Pasos Instrucciones detalladas Comentarios
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Tarea 20. Exportar un archivo CEF

Puede exportar un archivo CEF que contenga información sobre compuestos. 
Este archivo CEF puede importarse a otros programas como MassHunter 
Quantitative Analysis y Mass Profiler Professional. También puede importar 
compuestos que haya sido importados a un archivo CEF.

Tarea 20. Exportar un archivo CEF

Pasos Instrucciones detalladas Comentarios

1 Abra el archivo de datos 
MSD_mix_4stds_DG_spl200_03.d 
y ejecute File Open actions for the 
method iii_GCexercise2.m que fue 
creado en “Tarea 19. Configure y 
ejecute un método mediante el 
flujo de trabajo GC/Q-TOF 
Compound Screening” en la 
página 79.

a Si el programa no se abre, haga doble 
clic en el icono MassHunter 
Qualitative Analysis. También puede 
hacer clic en File > Open Data File.

b Haga clic en el archivo de datos 
MSD_mix_4stds_DG_spl200_03.d en 
la carpeta de archivos de datos de 
ejemplo GC.

c Marque la casilla de verificación Load 
result data.

d Marque la casilla de verificación Run 
‘File Open’ actions from selected 
method.

e Haga clic en el botón Use current 
method y haga clic en Open.

• Si ha terminado “Tarea 19. 
Configure y ejecute un método 
mediante el flujo de trabajo 
GC/Q-TOF Compound 
Screening” en la página 79, el 
método actual será 
iii_GCexercise2.m. Este método se 
configura para ejecutar el algoritmo 
Find Compounds by Chromatogram 
Deconvolution y ejecutar después 
un algoritmo Search Library en cada 
compuesto.

2 Exportar un archivo CEF. a Para exportar el archivo de manera 
interactiva, haga clic en File > 
Export > as CEF.

b Haga clic en el botón All results.
c Seleccione la ubicación del archivo de 

exportación.
d Haga clic en OK.

• Se utilizará un archivo CEF para 
exportar compuestos. 
Software MassHunter Workstation de Agilent - Guía de familiarización Qualitative Analysis para LC/MS 83



3 Utilizar flujos de trabajo, exportación e impresión
Tarea 20. Exportar un archivo CEF
Figura 51 Cuadro de diálogo Export CEF Options 

Tarea 20. Exportar un archivo CEF (continuación)

Pasos Instrucciones detalladas Comentarios
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Tarea 21. Imprimir un informe de análisis

Cuando desee imprimir un informe de análisis después de realizar cualquier 
de las tareas de este ejercicio o del siguiente, siga estas instrucciones. 

Los informes de análisis pueden contener los resultados de extraer e integrar 
cromatogramas, extraer espectros, encontrar compuestos, buscar en bases de 
datos espectros de pico o generar fórmulas a partir de espectros de pico. 

Tarea 21. Imprimir un informe de análisis

Pasos Instrucciones detalladas Comentarios

1 Si el archivo de datos 
MSD_mix_4stds_DG_spl200_03.d 
no está cargado, ábralo y ejecute 
File Open actions for the method 
iii_GCexercise2.m que fue creado 
en “Tarea 19. Configure y ejecute 
un método mediante el flujo de 
trabajo GC/Q-TOF Compound 
Screening” en la página 79.

a Si el programa no se abre, haga doble 
clic en el icono MassHunter 
Qualitative Analysis. También puede 
hacer clic en File > Open Data File.

b Haga clic en el archivo de datos 
MSD_mix_4stds_DG_spl200_03.d en 
la carpeta de archivos de datos de 
ejemplo GC.

c Marque la casilla de verificación Load 
result data.

d Marque la casilla de verificación Run 
‘File Open’ actions from selected 
method.

e Haga clic en el botón Use current 
method y haga clic en Open.

• Si ha terminado “Tarea 19. 
Configure y ejecute un método 
mediante el flujo de trabajo 
GC/Q-TOF Compound 
Screening” en la página 79, el 
método actual será 
iii_GCexercise2.m. Este método se 
configura para ejecutar el algoritmo 
Find Compounds by Chromatogram 
Deconvolution y ejecutar después 
un algoritmo Search Library en cada 
compuesto.

2 Cambie las selecciones del informe 
de análisis en el método:
• Marque las casillas de 

verificación de los 
cromatogramas, espectros o 
tablas que desea imprimir.

• Desmarque las casillas de 
verificación de los 
cromatogramas, espectros o 
tablas que no desea imprimir.

a En la ventana Method Explorer, haga 
clic en Reports > Analysis Report.

b Marque las casillas de verificación 
correspondientes a cualquier 
selección adicional que desee 
imprimir.

c Desmarque todos los cromatogramas 
y espectros que no desea imprimir.

• El informe Analysis solo contiene la 
información que marca en esta 
sección. 

• Si algún resultado no está 
disponible, dicho resultado no se 
imprimirá, aunque se encuentre 
marcado en esta sección. Por 
ejemplo, si no ha integrado el 
cromatograma la tabla de pico no se 
incluirá.
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Tarea 21. Imprimir un informe de análisis
Figura 52 Sección Analysis Report de las ventanas Method Explorer y Method Editor

3 Imprima el informe. a Puede imprimir interactivamente el 
informe de múltiples formas:
• Desde el menú principal, haga clic 

en File > Print > Analysis Report.
• Desde la barra de herramientas 

principal, haga clic en el icono 
Printer.

• Haga clic en el icono Print Analysis 
Report, , en la barra de 
herramientas Method Editor 
después de seleccionar la sección 
Analysis Report.

• Haga clic con el botón derecho de la 
sección Analysis Report en Method 
Editor, y haga clic en Print Analysis 
Report.

• Desde el menú de acceso directo del 
archivo de datos en Data Navigator, 
haga clic en Analysis Report.

b Haga clic en Report contents.
c Marque la casilla de verificación Print 

report y seleccione una impresora.
d Marque la casilla de verificación Print 

preview.
e Haga clic en el botón OK.

• El icono Run  de la barra de 
herramientas Method Editor en 
ocasiones le permite elegir una 
acción a partir de un conjunto de 
acciones posibles. Por ejemplo, si 
cambia a la sección Reports > 
Common Reporting Options de la 
ventana Method Editor, dispondrá 
de cuatro acciones distintas al 
pulsar en el icono Run. Si pulsa la 
flecha, se muestra una lista de 
posibles acciones y puede elegir 
qué acción realizar. Si elije una 
acción distinta de la lista, la acción 
por defecto cambia. Si simplemente 
hace clic en el botón Run, se lleva a 
cabo la acción actual por defecto.

Tarea 21. Imprimir un informe de análisis (continuación)

Pasos Instrucciones detalladas Comentarios

Por defecto, la ventana Method Editor 
queda flotante. Es visible como 
ventana separada del resto del 
programa Qualitative Analysis. Para 
anclar la ventana haga clic con el 
botón derecho en el título de la 
ventana y pulse Floating. También 
puede hacer doble clic en la barra de 
título para anclar la ventana.
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Tarea 21. Imprimir un informe de análisis
Figura 53 Cuadro de diálogo Print Analysis Report

f Revise el informe.
g Haga clic en el icono Close Print 

Preview de la barra de herramientas.

Figura 54 Ventana Print Preview con Analysis Report

Tarea 21. Imprimir un informe de análisis (continuación)

Pasos Instrucciones detalladas Comentarios
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Tarea 22. Imprimir un informe compuesto

Cuando desee imprimir un informe compuesto, siga estas instrucciones.

Tarea 22. Imprimir un informe compuesto

Paso Instrucciones detalladas Comentarios

1 Si el archivo de datos 
MSD_mix_4stds_DG_spl200_03.d 
no está cargado, ábralo y ejecute 
File Open actions for the method 
iii_GCexercise2.m que fue creado 
en “Tarea 19. Configure y ejecute 
un método mediante el flujo de 
trabajo GC/Q-TOF Compound 
Screening” en la página 79.

a Si el programa no se abre, haga doble 
clic en el icono MassHunter 
Qualitative Analysis. También puede 
hacer clic en File > Open Data File.

b Haga clic en el archivo de datos 
MSD_mix_4stds_DG_spl200_03.d en 
la carpeta de archivos de datos de 
ejemplo GC.

c Marque la casilla de verificación Load 
result data.

d Marque la casilla de verificación Run 
‘File Open’ actions from selected 
method.

e Haga clic en el botón Use current 
method y haga clic en Open.

• Si ha terminado “Tarea 19. 
Configure y ejecute un método 
mediante el flujo de trabajo 
GC/Q-TOF Compound 
Screening” en la página 79, el 
método actual será 
iii_GCexercise2.m. Este método se 
configura para ejecutar el algoritmo 
Find Compounds by Chromatogram 
Deconvolution y ejecutar después 
un algoritmo Search Library en cada 
compuesto.

2 Cambie algunas de las selecciones 
del método de informes 
compuestos:
• Desactive la opción de visionado 

de espectros MS aumentados en 
picos especiales.

• Desactive las opciones MS/MS 
en el informe.

a En la ventana Method Explorer, haga 
clic en Reports > Compound Report.

b Marque la casilla de verificación Show 
MS spectrum.

c Marque la casilla de verificación Show 
MS/MS spectrum.

d Marque la casilla de verificación Show 
MS/MS peak table.

• Estas casillas de verificación le 
permiten especificar la información 
que desea incluir en un informe si 
dicha información está disponible. 
Si la información no está disponible, 
se omitirá automáticamente esta 
sección. Por ejemplo, los resultados 
MS/MS nunca se incluyen cuando 
el archivo de datos solo contiene 
datos MS.
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Tarea 22. Imprimir un informe compuesto
Figura 55 Sección Compound Report en Method Editor

3 (opcional) Elegir una plantilla de 
informe de compuestos distintos.

a En la ventana Method Explorer, haga 
clic en Reports > Common Reporting 
Options.

b Seleccione CompoundReport
WithIdentificationHits.xlsx como 
plantilla de informe Compound.

• El software incluye varias plantillas 
de informes distintas.

• Puede personalizar una plantilla de 
informe usando Excel y el 
complemento Report Designer.

Figura 56 Sección Common Reporting Options en Method Editor

Tarea 22. Imprimir un informe compuesto

Paso Instrucciones detalladas Comentarios

La casilla de verificación Overlay 
compound chromatograms debe 
desmarcarse en datos GC/Q-TOF.

Puede utilizar Excel y el 
complemento Report Designer 
para personalizar cualquiera de 
las plantillas que tienen 
extensión XLTX. No puede 
personalizar el informe del 
método de adquisición.
Software MassHunter Workstation de Agilent - Guía de familiarización Qualitative Analysis para LC/MS 89



3 Utilizar flujos de trabajo, exportación e impresión
Tarea 22. Imprimir un informe compuesto
4 Imprima el informe. a Marque File > Print > Compound 
Report o haga clic en la flecha del 
icono Print Analysis Report, , y 
pulse Print Compound Report para 
imprimir el informe compuesto.

b Marque la casilla de verificación Print 
preview.

c Haga clic en OK. Examine el informe.
d Haga clic en el icono Close Print 

Preview.

• En el cuadro de diálogo Print 
Compound Report, puede 
seleccionar una impresora distinta, 
seleccionar guardar el informe en 
un archivo PDF o Excel, seleccionar 
si desea imprimir todos los 
resultados o solo aquellos que 
están resaltados, y si desea o no 
combinar distintos archivos de 
datos en el informe.

• Consulte la Ayuda en línea o el DVD 
Report Designer Training para 
obtener información adicional.

Figura 57 Ventana Print Preview con Compound Report

5 Cierre el archivo de datos sin 
guardar los resultados.

a Haga clic en File > Open Data File.
b Haga clic en No cuando se le pregunte 

si desea guardar los resultados.

Tarea 22. Imprimir un informe compuesto

Paso Instrucciones detalladas Comentarios
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Trabajo con ventanas

Al abrir el programa Qualitative Analysis por primera vez, aparecen cuatro 
ventanas en el diseño por defecto: Data Navigator, Method Explorer, 
Chromatogram Results y MS Spectrum Results. Puede alternar entre Navigator 
View y Compound Details View.

Puede lanzar otras diecisiete ventanas en Navigator View mediante el menú 
View: 

• Method Editor: le permite editar parámetros de método separados por 
distintas etiquetas

• Spectrum Preview: le permite escanear rápidamente los espectros de un 
archivo de datos

• MS Spectrum Results: muestra los espectros MS y MS/MS

• Difference Results: muestra los distintos resultados al efectuar una 
búsqueda en bibliotecas

• Deconvolution Results: muestra los espectros desconvolucionados

• Deconvolution Mirror Plot: muestra dos espectros desconvolucionados en 
una imagen duplicada

• UV Spectrum Results: muestra los espectros UV, solo disponible para datos 
LC/MS

• Integration Peak List: muestra los resultados de integración en una tabla

• MS Spectrum Peak List 1: muestra la tabla de picos del primer espectro 
seleccionado

• MS Spectrum Peak List 2: muestra la tabla de picos del segundo espectro 
seleccionado

• MS Actuals: muestra información de adquisición del espectro resaltado

• Compound List: muestra los compuestos que se han encontrado usando uno 
de los algoritmos de Find Compounds

• Compound Identification Results: muestra la información de identificación 
del compuesto seleccionado

• Spectrum Identification Results: muestra la información de identificación 
del espectro seleccionado

• MS/MS Formula Details: muestra una tabla que contiene fórmulas posibles 
calculadas para los fragmentos visualizados en un espectro MS/MS
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• Structure Viewer: muestra la estructura asociada con el compuesto o el 
espectro actuales

• Sample Information: muestra información sobre el archivo de datos 
resaltado

• Sequence Editor: permite editar una secuencia de métodos

También puede visualizar tres ventanas de herramientas que se mostrarán al 
empezar a usar la herramienta asociada:

• Formula Calculator

• Mass Calculator

• Recalibrate

Window Icons en la barra de herramientas principal

En la barra de herramientas principal, puede abrir y cerrar las ventanas usando 
estos iconos. Existen iconos adicionales si se instala el software MassHunter 
BioConfirm. Los comandos del menú View también pueden emplearse para abrir 
estas ventanas.
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MS Spectrum
Results

Data Navigator

Spectrum 
Preview

Chromatogram Results

Method Editor

Method Explorer

Integration Peak List

Spectrum 
Identification 
Results

MS Spectrum 
Peak List 1

Compound List

MS Spectrum 
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Deconvolution
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UV Spectrum 
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Difference 
Results
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Procesar los datos de resultado en Data Navigator

Ventanas y herramientas de Data Navigator

Data Navigator organiza todos los resultados de extracción y selección de 
espectros por archivo de datos o tipo de datos.

 

Al activarse (por defecto), si se resalta un 
cromatograma en Data Navigator también se 
resalta el espectro correspondiente. Los gráficos 
del cromatograma y espectro correspondientes 
también se resaltan. Linked Navigation solo 
funciona si ha empleado el elemento del menú 
Extract Peak Spectra desde el Menú 
Chromatograms, o si ha ejecutado alguno de los 
algoritmos de Compounds.

Marca única de verificación: marca las casillas 
de verificación de todos los datos resaltados.

Marcas de verificación dobles, una de ellas gris: 
marca las casillas de verificación de los datos 
resaltados y desmarca las demás casillas de 
verificación.

Marcas de verificación dobles: marca todas las 
casillas de verificación.

Los cromatogramas y espectros se visualizan 
cuando sus casillas de verificación están 
marcadas.

Herramientas de marcas de 
verificación

Icono Linked Navigation 
Software MassHunter Workstation de Agilent - Guía de familiarización Qualitative Analysis para LC/MS 95



4
Realizar operaciones en el cromatograma
Realizar operaciones en el cromatograma

Puede realizar las siguientes operaciones en todo el cromatograma o en una parte 
seleccionada del cromatograma usando los elementos del menú:

Acción Elemento del menú

Cambia etiquetas de picos en el 
cromatograma

Configuration > Chromatogram Display Options

Extrae un cromatograma Chromatograms > Extract Chromatograms

Extrae cromatogramas definidos Chromatograms > Extract Defined Chromatograms

Integra el cromatrograma Chromatograms > Integrate Chromatogram

Integrar y extraer espectros de picos Chromatograms > Integrate and Extract Peak Spectra

Integra y desconvoluciona espectros de 
picos

Chromatograms > Integrate and Deconvolute Peak 
Spectra

Suaviza el cromatograma Chromatograms > Smooth Chromatogram

Sustrae cualquier cromatrograma Chromatograms > Subtract Any Chromatogram

Calcula la relación señal/ ruido Chromatograms > Calculate Signal-to-Noise

Encuentra compuestos a partir de datos 
MS/MS automáticos

Find > Find Compounds by Auto MS/MS

Encuentra compuestos a partir de datos 
MS/MS objetivo

Find > Find Compounds by Targeted MS/MS

Encuentra compuestos para datos MS(1) Find > Find Compounds by Molecular Feature

Encuentra compuestos para datos GC/MS Find > Find Compounds by Chromatogram 
Deconvolution

Encuentra compuestos para datos MRM Find > Find Compounds by MRM

Encuentra compuestos por resutados de 
integración

Find > Find Compounds by Integration

Encuentra compuestos que coinciden con 
fórmulas específicas

Find > Find Compounds by Formula
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Seleccionar operaciones en rango desde el menú de acceso directo

Cuando se selecciona un rango cromatográfico, también se puede extraer un 
espectro y extraer un espectro al fondo, además de las opeacines mencionadas 
anteriormente y otras no mencionadas.

1 Para acceder a estas operaciones, haga clic en la herramienta Range Select 
( ) en la barra de herramientas Chromatogram Results. 

2 Haga clic en el punto en el que desea iniciar el rango, arrastre el cursor sobre 
un rango y suelte el botón del ratón.

3 Haga clic con el botón derecho del ratón en el cromatograma y pulse en la 
operación desde el menú de acceso directo.

Guarde los resultados en el archivo o archivos de datos

• Haga clic en el icono Save ( ), o en File > Save Results.

Cuando salga del programa, también se le preguntará si desea guardar los 
resultados en el archivo de datos, a menos que haya desactivado esta función 
(la función se desactiva en el cuadro de diálogo Message Box Options)

Realizar operaciones en un espectro MS o MS/MS 

Puede realizar las siguientes operaciones en un espectro MS o MS/MS, o bien en 
una región determinada de un espectro MS o MS/MS usando los elementos de 
menú:

Acción Elemento del menú

Ver el m/z, abundancia, estado de carga y 
otros datos sobre los picos de un espectro

View > MS Spectrum Peak List 1

Cambia las etiquetas de pico espectral Configuration > MS and MS/MS Spectra Display 
Options

Sustrae el espectro de fondo Spectra > Subtract Background Spectrum

Sustrae cualquier espectro Spectra > Subtract Any Spectrum (y, seguidamente, 
pulsar en otro espectro)

Une dos espectros Spectra > Add Any Spectrum (y, seguidamente, 
pulsar en otro espectro)
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Trabaja con datos visuales cromatográficos

Ventana Chromatogram Results

Busca en una base de datos entradas que 
coincidan con masas específicas de un 
espectro

Spectra > Search Database for Spectrum Peaks

Genera fórmulas para las masas en el 
rango seleccionado de un espectro 

Spectra > Generate Formulas from Spectrum Peaks 
(cuando se selecciona un rango en el espectro MS)

Desconvoluciona mediante el algoritmo 
Resolved Isotope 

Spectra > Deconvolute (Resolved Isotope)

Busca biblioteca Identify > Search Library for Spectra o
Spectra > Search Library for Spectra

Acción Elemento del menú
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Herramientas de resultados de cronograma

Trabajar con datos visuales espectrales

Ventana MS Spectrum Results 

Herramientas de zoom 
en orden

Herramientas de selección en 
orden Range Select: si está en posición On, puede arrastrar un 

rango de cromatogramas para realizar acciones en ellos.

Peak Select: cuando se encuentra en posición On, puede 
seleccionar el espectro de un pico integrado en máximo.

Manual Integration: cuando se encuentra On, puede 
realizar integraciones de manera interactiva.

Walk Chromatogram: cuando se encuentra en posición 
On, puede visualizar espectros individuales mientras hace 
clic en cada punto, o usar las flechas derecha e izquierda 
del teclado.

Annotation: cuando se encuentra On, puede añadir 
anotaciones de imagen y texto a los cromatogramas.

Autoescalar eje X y eje Y

Autoscalar eje X

Autoscalar eje Y

Alejar zoom

Autoescalar eje Y durante el zoom

Modo eje Y enlazado

Siempre es necesario 
seleccionar una de estas 
herramientas.
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Herramientas de resultados de espectro MS

Flujos de trabajo

Los flujos de trabajo le ayudan a personalizar la interfaz de usuario de su 
aplicación. Cada flujo de trabajo carga un método distinto con los parámetros 
apropiados para dicho flujo de trabajo. Asimismo, cada flujo de trabajo carga 
un diseño distinto; estos diseños incluyen personalizar las columnas que se 
muestran en cada tabla. Por último, cuatro de los diseños también incorporan 
una sección especial de edición de métodos que contiene copias de las 
secciones del editor de métodos relevantes para el flujo de trabajo. Agrpar las 
funciones que se utilizan conjuntamene en un flujo de trabajo específico 
facilita personalizar el método.

El programa Qualitative Analysis incluye varios flujos de trabajo distintos. 
Ellos son:

• General

Herramientas de zoom 
en orden

Herramientas de 
selección en orden

Range Select: si está en posición On, puede arrastrar un 
rango de cromatogramas para realizar acciones en ellos.

Annotation: cuando se encuentra On, puede añadir 
anotaciones de imagen y texto a los cromatogramas.

Calipers: cuando se encuentra en posición On, puede 
añadir un calibrador Delta Mass al espectro seleccionado. 
En la ventana Deconvolution Results, también puede 
añadir un calibrador de aminoácidos o un calibrador de 
modificaciones. Consulte la ayuda en línea para obtener 
más información.

Autoescalar eje X y eje Y

Autoscalar eje X

Autoscalar eje Y

Alejar zoom

Autoescalar eje Y durante el zoom

Modo eje Y enlazado

Para desmarcar la 
selección de una 
herramienta, haga clic 
en otra herramienta o 
icono.
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• BioConfirm: estos flujos de trabajo solo están disponibles si el software 
BioConfirm está instalado y marcado en el cuadro de diálogo User Interface 
Configuration. BioConfirm cuenta con varios flujos de trabajo posibles, 
dependiendo del tipo de análisis que desea realizar. BioConfirm se emplea 
con archivos de datos LC/MS.

• Chromatogram Peak Survey

• Formula Confirmation and Sample Purity

• MS Target Compound Screening

• GC/Q-TOF Compound Screening

Si trabaja con datos GC/MS, puede seleccionar el flujo de trabajo General o el 
flujo de trabajo GC/Q-TOF Compound Screening. Si trabaja con datos LC/MS, 
puede seleccionar cualquiera de los flujos de trabajo excepto GC/Q-TOF 
Compound Screening.

Método específico

Cada flujo de trabajo carga un método específico por defecto con los ajustes 
apropiados para dicho flujo de trabajo. Por ejemplo, si cambia a uno de los 
flujos de trabajo BioConfirm, el Tipo de datos objetivo del algoritmo Find 
Compounds by Molecular Feature se ajusta a Large molecules (proteínas, 
oligoelementos). Esta configuración es apropiada para el flujo de trabajo 
BioConfirm pero, por defecto, no lo es para los demás flujos de trabajo.
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Diseño específico

Además, cada flujo de trabajo carga un diseño específico. Los diseños 
consisten en lo siguiente:

• Posición y tamaño de cada ventana

• Qué ventanas se etiquetan

• Qué ventanas son flotantes

• Qué ventana etiquetada es la principal

• Qué ventana es visible por defecto

• Visibilidad de la barra de estado 

En cada ventana de gráficos (ventana Chromatogram Results, ventana 
Spectrum Preview, ventana MS Spectrum Results, ventana Deconvolution y 
ventana UV Results), se guarda la siguiente información:

• Superposición o no de los gráficos

• Activación del modo Autoescalar eje Y durante el zoom 

• Activación del modo Eje Y enlazado

En cada ventana de tabla, se guarda lo siguiente

• Visibilidad de cada columna

• Orden de las columnas

• Anchura de cada columna

• Filtros que se han añadido a la tabla (solo disponible para la tabla 
Compound List, la tabla Compound Identification Results y la ventana 
Spectrum Identification Results).

Sección específica de Method Explorer y Method Editor

Si utiliza Method Editor con el flujo de trabajo General, puede cambiar 
prácticamente todos los parámetros del Método. 

Cada uno de los cuatro demás flujos de trabajo cambia las secciones 
disponibles en Method Explorer. Cada nueva sección contiene solo las 
pestañas y secciones de Method Editor que son útiles para dicho flujo de 
trabajo. Cambiar un parámetro en la sección de flujo de trabajo también 
cambia el parámetro de la sección correspondiente de las secciones Method 
Editor generales.
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Dos pestañas no se repiten en las secciones Method Editor generales. La 
sección Chromatogram Peak Survey Workflow > Spectrum Peak 
Identification y la pestaña Chromatogram Peak Survey Workflow > 
Chromatogram Extraction > Chromatograms solo están incluidas en el flujo 
de trabajo Chromatogram Peak Survey. Estas secciones solo afectan al 
algoritmo Chromatogram Peak Survey. Este algoritmo solo se emplea en este 
flujo de trabajo y en la acción Chromatogram Peak Survey without Report y 
la acción Chromatogram Peak Survey with Analysis Report.

Métodos y diseño de los flujos de trabajo

Con cada flujo de trabajo se incluyen métodos y diseños adicionales por 
defecto. 

Flujo de trabajo Método Diseño Sección de Method Editor

General default.m Default.xml Ninguno

BioConfirm Intact 
Protein

BioConfirm
IntactProtein-
Default.m

BioConfirm-
IntactProtein-
MaximumEntropy-
Default.xml

BioConfirm Workflow

BioConfirm High 
Mass Intact Protein

BioConfirm
IntactProtein
HighMass
Default.m

BioConfirm
IntactProtein
LMFE.xml

BioConfirm Workflow

BioConfirm Small 
Oligonucleotides

BioConfirmOligo
nucleotideSmall.m

BioConfirmOligo-
nucleotide.xml

BioConfirm Workflow

BioConfirm Large 
Oligonucleotides

BioConfirmOligo
nucleotideLarge-
Default.m

BioConfirmOligo-
nucleotide.xml

BioConfirm Workflow

BioConfirm Protein 
Digest

BioConfirmProtein
Digest-Default.m

BioConfirm
ProteinDigest.xml

BioConfirm Workflow

BioConfirm 
Synthetic Peptide

BioConfirmSynthetic
Peptide-Default.m

BioConfirm
SyntheticPeptide.xml

BioConfirm Workflow

Chromatogram Peak 
Survey

ChromPeakSurvey-
Default.m

Default.xml Chromatogram Peak 
Survey Workflow
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Flujos de trabajo
Formula 
Confirmation and 
Sample Purity

SamplePurity-
Default.m

SamplePurity-
Default.xml

Formula Confirmation and 
Sample Purity Workflow

MS Target 
Compound 
Screening

Screening-Default.m Screening-Default.xml MS Target Compound 
Screening Workflow

GC Q-TOF 
Compound 
Screening

GC_Q-TOF.m QTOFData.xml GC/Q-TOF Compound 
Screening

Flujo de trabajo Método Diseño Sección de Method Editor
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Personalizar una plantilla de informe
Personalizar una plantilla de informe

En la Ayuda en línea, podrá consultar el complemento MassHunter Report 
Designer, la guía de familiarización de Report Designer o el DVD de formación 
en creación de informes para ampliar detalles sobre cómo modificar una 
plantilla de informe. Los siguientes pasos proporcionan una idea rápida sobre 
lo que significa personalizar una plantilla.

1 Vaya a la carpeta que contiene las plantillas de informe. Por defecto, la plantilla 
es \MassHunter\Report Templates\Qual\B.05.00\en-US\Letter. Puede seleccionar 
una carpeta distinta en Method Explorer en la pestaña General > Common 
Reporting Options > Templates.

2 Haga una copia de la plantilla que desea modificar. Haga clic con el botón 
derecho y pulse Properties. Si es necesario, desmarque la casilla de 
verificación Read-only. Seguidamente, haga clic con el botón derecho y pulse 
Open en el menú de acceso directo.

Al abrir una plantilla de esta forma, Excel sabrá que el archivo es una plantilla. 
Cuando la plantilla se encuentre abierta, podrá modificar los encabezados y 
pies de página y añadir, eliminar o mover columnas de parámetros. Consulte la 
ayuda en línea para obtener más información. Todas las plantillas de 
Qualitative Analysis están marcadas como Solo lectura. Cambie esta propiedad 
antes de editar la plantilla.
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Personalizar una plantilla de informe
Con el programa Analysis se instalan muchas plantillas. Consulte la ayuda 
en línea de Qualitative Analysis para obtener más información sobre el 
contenido de cada plantilla de informe.

3 Realice los cambios que desee.

Si desea ampliar información sobre cómo modificar una plantilla, consulte 
la ayuda en línea del complemento MassHunter Report Designer, o el DVD 
de formación en Agilent MassHunter Reporting.

4 Para guardar la nueva plantilla, haga clic en Guardar o en Guardar como > 
Otros formatos desde el botón de Microsoft Office. 

5 Escriba un nombre y  haga clic en Guardar.
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